Preface

Copyright

This manual is published by PerkinElmer, Inc., 68 Elm Street, Hopkinton, MA 01748 USA. Copyright 2016 PerkinElmer, Inc., and its parent, affiliated, and subsidiary companies. All rights reserved, including but not limited to those rights to reproduce this publication or parts thereof. Reproduction of this publication or parts thereof, or the products it describes, by any means or in any form is expressly prohibited without the written permission of PerkinElmer.

Trademarks

PerkinElmer and the PerkinElmer logo are registered trademarks of PerkinElmer, Inc. and/or its parent, affiliates, and/or subsidiary companies (collectively “PerkinElmer”). AccuCT is a trademark of PerkinElmer, Inc. and/or its parent, affiliates, and/or subsidiary companies (collectively “PerkinElmer”). Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks and registered trademarks are the property of their respective holders.

Content

Any errors or omission which may have occurred in this publication despite the utmost care taken in its production will be corrected as soon as possible, but not necessarily immediately upon detection. PerkinElmer provides this publication “As Is” without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability or fitness for a particular purpose. Some states or jurisdictions do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you. PerkinElmer reserves the right to revise this publication and to make changes from time to time in the content hereof without obligation of PerkinElmer to notify any person of such revision or changes. Further, PerkinElmer may make modifications to the product described in this manual at any time without any obligation to notify any person of such modifications.

Contact Us

If you have a question about a product that is not answered in this manual or online Help, or if you need assistance regarding this product, please contact the PerkinElmer Technical Support Center from 8:00 A.M. to 8:00 P.M., Eastern Time, Monday through Friday:

Phone: (US Toll Free): 800-762-4000
       (Worldwide): +1 203-925-4602

Fax: +1 203-944-4904

Email: global.techsupport@perkinelmer.com

Internet: www.perkinelmer.com

Before you call, have the following information available for the technical representative:

• Software version (found by choosing About from the main Help menu).
• If applicable, the error message shown in the software.
Product Service and Customer Support Plans

PerkinElmer offers a full range of services to ensure your success. From our original factory warranty through a comprehensive line of customer support plans, PerkinElmer offers you Field Service Engineers and in-house Specialists who are dedicated to supporting your hardware, software, and application development needs.

Phone: (US Toll Free): 800-762-4000
   (Worldwide): +1 203-925-4602
Fax: +1 203-944-4904
Email: global.techsupport@perkinelmer.com

Our programs can include such useful services as:

- Preventive maintenance
- Diagnostic servicing performed on-site by PerkinElmer field service engineers or remotely via Technical Support
- Validation performed on-site by PerkinElmer field service engineers
- Extended use of the PerkinElmer Technical Support Center
- Software updates
- Parts, labor, and travel expense coverage
- Other customized services upon request

Training For Your Product

Contact PerkinElmer for information about the availability of training courses for your product:

Phone: (US Toll Free): 800-762-4000
   (Worldwide): +1 203-925-4602
Fax: +1 203-944-4904

Table of Symbols

Table 1 contains symbols that identify particularly important information and alert you to the presence of hazards. These symbols may appear in this manual and/or on the product it describes.

Table 1. Important Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>NOTE: A cautionary statement; an operating tip or maintenance suggestion; may result in instrument damage if not followed. REMARQUE: Énoncé indiquant une précaution à prendre, un conseil de fonctionnement ou une suggestion d’entretien; son non-respect peut provoquer des dommages à l’instrument.</td>
</tr>
</tbody>
</table>
# Table of Contents

Preface .................................................................................................................... 2  

Introduction ............................................................................................................. 7  
  Principles of Operation ......................................................................................... 8  
  System Requirements .......................................................................................... 12  

Basic Operation ...................................................................................................... 13  
  Installing the Software ...................................................................................... 14  
  Opening the Software ...................................................................................... 15  
  Changing the View of the Main Window ............................................................ 16  
  Closing the Software ...................................................................................... 17  

Study Management ................................................................................................. 18  
  Creating a Study ............................................................................................... 19  
  Defining Study Parameters ............................................................................... 20  
    General Study Information ............................................................................... 21  
    Imaging Agents .............................................................................................. 22  
    Study Groups ................................................................................................. 23  
    Animals ........................................................................................................... 24  
  Opening an Existing Study ............................................................................... 29  
  Importing Study Data ...................................................................................... 30  
    Format the File .............................................................................................. 30  
    Review the File for Errors ........................................................................... 33  

Data Analysis ........................................................................................................... 35  
  Understanding Workflows ............................................................................... 36  
    Workflow Steps .............................................................................................. 36  
    Recomputing a Step ...................................................................................... 37  
    Completed Workflows .................................................................................. 37  
  Associating Scan Data ...................................................................................... 38  
  Viewing the Scan Data ...................................................................................... 40  
    Zoom In ....................................................................................................... 41  
    Zoom Out .................................................................................................... 41  
    Pan .............................................................................................................. 41  
    Rotate .......................................................................................................... 41  
    Reset ........................................................................................................... 42  
    Export ......................................................................................................... 42  
  Adjusting the Scan Data Properties .................................................................. 43  
    Window and Level ....................................................................................... 44  
    Colormap ..................................................................................................... 46  
    2D Display ................................................................................................. 47  
    3D Display ................................................................................................. 48  
    Invert ......................................................................................................... 48  
    Reset Settings ........................................................................................... 49  
  Changing the HU Calibration ......................................................................... 49  
  Performing the ASBMR Morphometry Workflow .......................................... 50
# Table of Contents

Starting the ASMBR Morphometry Workflow ........................................................... 51
Detect Bones ........................................................................................................... 52
Separate Bones ...................................................................................................... 53
Segment More ........................................................................................................ 55
Join Segments ........................................................................................................ 58
Segment Bone Compartments .................................................................................. 60
Define ROI ............................................................................................................... 63
ASBMR Measurements ............................................................................................ 66

Performing the Calibrate BMD Workflow ............................................................... 68
Associate BMD Phantom Scan Data ....................................................................... 69
Start the Calibrate BMD Workflow ......................................................................... 70
Segment BMD Phantom .......................................................................................... 71
Calibrate BMD Phantom ......................................................................................... 72

Performing Whole Scan BMD and Single Bone BMD Workflows ........................... 74
Associate a Calibrate BMD Workflow to Scan Data ............................................... 75
Starting the BMD Workflow .................................................................................... 76
Detect Bones .......................................................................................................... 76
Separate Bones ...................................................................................................... 76
Segment More ........................................................................................................ 77
Join Segments ........................................................................................................ 77
Define ROI ............................................................................................................... 77
BMD Measurements ............................................................................................... 78

Performing the Bone Growth and Bone Loss Workflows ...................................... 80
Starting the Bone Growth or Bone Loss Workflow ................................................ 81
Detect Bones .......................................................................................................... 81
Separate Bones ...................................................................................................... 81
Segment More ........................................................................................................ 81
Join Segments ........................................................................................................ 82
Define ROI ............................................................................................................... 82
Bone Growth and Bone Loss Measurements ......................................................... 82

Exporting the Measurement Results ...................................................................... 83
Opening an Existing Workflow .............................................................................. 83
Renaming a Workflow ............................................................................................ 84

Software Reference ............................................................................................... 85
AccuCT Main Window ............................................................................................. 86
Menu Bar .................................................................................................................. 87
Animals & Data Tab ................................................................................................. 88
Calibration Data Tab ............................................................................................... 89
Study Info Tab ......................................................................................................... 91
3D Visualization Tab ............................................................................................... 91
Measurements Tab ................................................................................................. 93
Plots Tab ............................................................................................................... 94
Step Settings Tab .................................................................................................. 95
Visualization Settings Tab ..................................................................................... 98
Workflow Viewer Tab .............................................................................................. 100
About Window ...................................................................................................... 102
Add Groups Window ............................................................................................. 103
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change HU Calibration Window</td>
<td>104</td>
</tr>
<tr>
<td>Choose Calibration Scan Window</td>
<td>105</td>
</tr>
<tr>
<td>Import Data Window</td>
<td>106</td>
</tr>
<tr>
<td>Import Phantom Data Window</td>
<td>107</td>
</tr>
<tr>
<td>Manage Animals Window</td>
<td>108</td>
</tr>
<tr>
<td>New Study Window</td>
<td>110</td>
</tr>
<tr>
<td>Open Study Window</td>
<td>111</td>
</tr>
<tr>
<td>Restore Animals to Study Window</td>
<td>112</td>
</tr>
<tr>
<td>Select Agents Window</td>
<td>113</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>114</td>
</tr>
<tr>
<td>Cannot Add Animals to a Study</td>
<td>115</td>
</tr>
<tr>
<td>Cannot Compute a Step</td>
<td>115</td>
</tr>
<tr>
<td>Cannot Pick Bones</td>
<td>115</td>
</tr>
<tr>
<td>Cannot View 2D or 3D Display</td>
<td>116</td>
</tr>
<tr>
<td>Errors When Importing Study Data</td>
<td>116</td>
</tr>
<tr>
<td>Click-Through License Agreement</td>
<td>117</td>
</tr>
<tr>
<td>Index</td>
<td>125</td>
</tr>
</tbody>
</table>
Introduction

This user manual explains how to operate the AccuCT software. It includes procedures for creating studies, assigning scan data to animals in studies, performing analysis, exporting measurement results, and software troubleshooting.

NOTE

The manual provides detailed instructions and screen shots. Some screen shots in the manual may not exactly match those displayed on your monitor.

This section of the manual contains the following topics:

• Principles of Operation on page 8
• System Requirements on page 12
Principles of Operation

The AccuCT software package is designed to streamline and simplify segmentation and analysis of micro-computed tomography (µCT) images.

Many µCT studies require managing a large number of images. The AccuCT software contains built-in data management tools specifically designed to simplify organization and data synthesis. Each dataset can then be processed using workflows optimized for specific applications and measurement outcomes. See Figure 1.

![Figure 1. Data Management Tools](image)

Each workflow includes a sequence of steps that may involve detection, segmentation, and/or computational aspects. Each step has a set of inputs and outputs. Wherever possible, inputs are simplified to represent high level functions, allowing the focus to be on an end experimental goal, rather than a specific algorithmic implementation. Outputs are predefined for simplicity. See Figure 2 for an example of workflow steps.

![Figure 2. Workflows Consist of Steps](image)

Detection steps in the workflow use a hybrid thresholding algorithm that combines multiple thresholding techniques and edge detection to create a mask of bone voxels.
Bone separation steps in the workflow use splitting filters to automatically separate individual bones and label each bone individually, with the results being easily adjustable in the event of under-segmentation (see Figure 3) or over-segmentation (see Figure 4).

**Figure 3. Under-Segmentation Adjustments**

**Figure 4. Over-Segmentation Adjustments**
Bone compartment segmentation steps then separate cortical bone, trabecular bone and marrow using morphological operations and filtering steps specifically designed to capture these compartments without being biased by growth plates within a bone. See Figure 5.

**Figure 5. Bone Compartment Segmentation**

If desired, an ROI step can be added after bone compartment separation to calculate measurements for the defined area instead of the entire bone.

**Figure 6. Define ROI Step**
If computations include bone mineral density (BMD), calibration curves derived from images of industry standard phantoms are automatically included. See Figure 7.

![Calibration Curve](image)

**Figure 7. Calibration Curve for BMD Computations**

Lastly, experimentally meaningful computations are selected, calculated, and presented in a simple fashion for interpretation and subsequent data synthesis. See Figure 8.

![Measurement Tab](image)

**Figure 8. Measurement Tab**
System Requirements

**Operating Systems:** Microsoft® Windows® 7 SP1, 8.1, or 10, 64-bit, U.S. English, Professional Full Version.

**Minimum RAM:** 16GB

**Processor:** Intel i7

**Graphics card:** OpenGL 4.0 support required. CAD- or gaming-quality NVidia card highly recommended.
Basic Operation

This section includes instructions for the basic operation of the AccuCT software, including:

• Installing the Software (see page 14)
• Opening the Software (see page 15)
• Changing the View of the Main Window (see page 16)
• Closing the Software on page 17 (see page 17)
Installing the Software

To install the AccuCT software:


2. Double-click the AccuCT Setup icon. The installer opens (see Figure 9).

3. To change the location of the installation from the default, click the Options button. The Setup Options window displays (see Figure 10). Click the Browse button, navigate to the desired install location, and click the OK button.

4. Click the Install button, and click the Close button when the installation completes.
Opening the Software

To open the AccuCT software:

1. Double-click the AccuCT icon on the desktop.

2. Type your AccuCT license key number into the text box and click the OK button (first time use only).

The AccuCT Main Window displays as shown in Figure 11.

Figure 11. View of AccuCT Main Window at Start-up
Changing the View of the Main Window

If desired, the view of the tabs on the AccuCT Main Window can be customized to display data according to the user preferences. These options do not change the raw data but provide different means of positioning the tabs on the AccuCT Main Window.

The Animals & Data Tab, Calibration Data Tab, and Study Info Tab may be minimized and docked on left side of the main window.

The Step Settings Tab and Visualization Settings Tab can be minimized and docked on the right side of the main window.

The Workflow Viewer Tab can be minimized and docked at the bottom of the main window.

Figure 12 displays the AccuCT Main Window when the tabs listed above are minimized and docked in their applicable positions.

To change the view of any tab:

1. Click the vertical pin icon on the top right side of the tab to be moved. See Figure 13.
The tab is now docked vertically on the left side of the main window. See Figure 14.

Figure 14. Animals & Data Tab Docked on Side of Main Window

To change the view of the tab back to its original view, click the docked tab and then click the horizontal pin icon. See Figure 15.

Figure 15. Horizontal Pin Icon on Animals & Data Tab

The tab returns to its default position. See Figure 11.

Closing the Software

Use one of the following methods to close the AccuCT software:

- Select File → Exit from the Menu Bar.
- Click ALT + F4 keys
- Click the Close icon on the top right side of the AccuCT Main Window.
Study Management

This section includes general procedures for using the AccuCT software to organize data into studies, including:

- Creating a Study (see page 19)
- Defining Study Parameters (see page 20)
- Opening an Existing Study (see page 29)
- Importing Study Data (see page 30)
Creating a Study

When the AccuCT software is opened, a study can be created to organize your data.

To create a study:

2. Type the study name into the Enter a study name text box.
3. Click the Create Study button. The study is automatically saved and its name displays on top of the Animals & Data Tab.

NOTE

Studies may also be created by importing a .csv or .yaml file. See Importing Study Data on page 30.
Defining Study Parameters

After a study is created, use the Study Info Tab to define the study parameters. This section describes how to add, edit, remove or delete the following parameters:

- General Study Information (see page 21)
- Imaging Agents (see page 22)
- Study Groups (see page 23)
- Animals (see page 24)

**NOTE**

In this section, “delete” is used to indicate a permanent deletion of a parameter that can **NOT** be undone. “Remove” is used to indicate the removal of a parameter **CAN** be undone.
General Study Information

This section describes how to add and edit the general information about the study.

Add General Study Information

To add general information about the study:

1 Click the Study Info Tab. The study name displays on top of the tab.

2 Type over Enter a study description with a brief description of the study (optional).

3 Type your approved Institutional Animal Care and Use Committees protocol ID number into the IACUC Protocol ID text box (optional).

4 Type over Enter an animal model with the model used in the study, e.g., 4T1 breast tumor, ovariectomy, etc. (optional).

5 Type the study start date into the Start Date text box or select the date from the pop-up calendar. If the start date is unknown, leave TBD in the text box.

6 Click the Add button. The defined general information parameters display on the Study Info Tab.

Edit General Study Information

To edit the general information about the study:

1 Open the Study Info Tab.

2 Edit the study description, IACUC protocol ID, animal model, or start date as desired.
Imaging Agents

This section describes how to add and remove imaging agents from the study.

**NOTE**

Adding imaging agents to a study is optional.

Add Agents

To add agents to the study:

1. Click the **Add an Agent** button on the **Study Info Tab**. The **Select Agents Window** opens.

2. Select the desired **Modality Type** from the drop-down list. The applicable agent or dye types display on the text box.

3. Click the arrow next to the agent or dye type.

4. Click the name of the agent or dye to add. The details of the selected agent or dye display under the text box. See **Figure 16**.

![Select Agents Window](image)

**Figure 16. Select Agents**

5. Click the **Add** button. The **Select Agents Window** closes and the selected agent name displays above the **Add an agent button** on the **Study Info Tab**.

6. To add additional agents to the study, repeat steps 1 to 5 above.
Remove Agents

To remove agents from the study:

1. Hover the mouse cursor over the agent to be removed on the Study Info Tab.
2. Click the X icon as shown Figure 17. The Remove Agent window opens.

3. Click the Yes button on the Remove Agent window. The agent is removed from the Study Info Tab.

Study Groups

This section describes how to add, edit, and delete study groups.

NOTE

Adding study groups to the study is optional.

Add a Study Group

To add a study group:

1. Click the Add a study group button on the Study Info Tab. The Add Groups Window window opens.
2. Type over Enter a study group name with the name of the study group.
3. Type over Enter a description with a description of the study group (optional).
4. Select the group type from the Group Type drop-down list.
5. If applicable, click the check box next to the desired agent name in the Available Agents field. The selected agent or agents display on the Selected Agents text box.
6. Click the OK button. The Add Groups Window closes and the study group name displays above the Add a study group button on the Study Info Tab.
7. To add additional study groups, repeat steps 1 to 6 above.
Delete a Study Group

To delete a study group:

1. Hover the mouse cursor over the study group name on the Study Info Tab and click the X icon. The Delete Study Group window opens.

2. Click the Yes button on the Delete Study Group window. The study name is removed from the study.

Edit a Study Group

To edit a study group:

1. Hover the mouse cursor over the study group name on the Study Info Tab and click the pencil icon. The Edit Group window opens.

2. Make the desired changes to the group name, group description, group type, and selected agents on the Edit Group window.

3. Click the OK button. The update group name displays on the Study Info Tab.

Animals

This section describes how to add, edit, delete, and remove animals and their parameters from a study.

Add Animals

To add animals to a study or study group:

1. Click the Add or edit animals button on the Study Info Tab. The Manage Animals Window opens.

2. Select the type of animal in the study from the Animal Type drop-down list.

3. Select the strain or breed of the animals from the Strain or Breed drop-down list (optional).

4. Select the sex of the animal from the Sex drop-down list.

5. Type the birth date of the animal into the Birth Date numeric text box or select the date from the pop-up calendar (optional).

6. Type the weight of the animal in the Weight (kg or gm) numeric text box or use the arrow keys (optional).
7 To assign custom names to animals in the study, click the **Animals are named** radio button.

8 If the animals are named by identification numbers:

a Click the **Animals have IDs** radio button.

b Type over *ID* in the **Starting ID** text box with a starting number, letter, or name. See **Figure 18**.

![Figure 18. Animal Properties](image)

9 Type the number of animals in the study in the **Animal(s)** numeric text box, or use the arrows keys.

10 Click the **Add** button. The table on the **Manage Animals Window** auto-fills with the assigned animals names, types, subspecies (strain or breed), sex, birth dates, weights, and study group name.

**NOTE**

*If the Add button is not clicked before the Done button, the animals will not be added to the study or study group.*

11 Click the **Done** button. The **Manage Animals Window** closes and the animal names display on the **Animals & Data Tab**.

12 To add additional animals the study, repeat steps 1 to 11 above.
Delete Animals

To delete an animal from permanently from a study or study group:

**NOTE**

*Deleting an animal permanently removes the animal and its data from a study or study group. When an animal is deleted, it cannot be restored.*

1. Right-click the animal to be deleted on the Animals & Data Tab.
2. Select **Delete** from the context menu. The **Delete Animal window** opens.
3. Click **Yes** on the Delete Animal window. The animal is removed from the Animals & Data Tab.

Remove Animals

To remove an animal from a study or study group:

**NOTE**

*If an animal dies during the study or is excluded as a result of protocol criteria, the animal can be removed from a study or study group. When an animal is removed, data analysis can still be performed on any scan associated with the animal, but new scans cannot be associated with the animal.*

1. Click the **Study Info Tab**.
2. Click the **Add or edit animals** button. The **Manage Animals Window** opens.
3. Hover the mouse cursor over the table row of the animal to be removed. An **X** icon displays at the end of the row.
4 Move the mouse to the X icon. Click the X icon when the X turns red. See Figure 19.

![Figure 19. Remove Animal from Study](image)

5 Click the Yes button. The animal is removed from the Manage Animals Window but its name is shaded on the Animals & Data Tab, allowing you to perform data analysis on the current scan associated with the animal.

6 Click the Done button. The Manage Animals Window closes.

**Rename Animals**

To rename an animal in a study or study group:

1 Click the animal to be renamed on the Animals & Data Tab and then right-click the animal.

2 Select Rename Animal from the context menu.

3 Type the new name into the text box on the Rename Animal Window.

4 Click OK. The new animal name displays on the Manage Animals Window and Animals & Data Tab.

OR

1 Click the Study Info Tab.

2 Click the Add or edit animals button. The Manage Animals Window opens.

3 Hover the mouse cursor over the table row of the animal to be renamed.

4 Click the Animal field in the row and type a new name into the field.

5 Click the Done button. The new animal name displays on the Animals & Data Tab.
Restore Animals

To restore an animal removed from a study or study group:

1. Click the **Add or edit animals** button on the **Study Info Tab**. The **Manage Animals Window** opens.

2. Click the **Restore** button. The **Restore Animals to Study Window** opens.

3. Select the check box next to the animal to restore to the study and click the **Restore** button.

4. Click the **Done** button. The restored animal name displays on the **Animals & Data Tab**.
Opening an Existing Study

To open an existing study:

1. Select File → New Study from the Menu Bar and select Open Study.

   OR

   Press CTRL + O. The Open Study Window opens.

2. Select the study to be opened from the list displayed on the window, or type the name of the study in the Find studies text box.

3. Select the study to be opened.

4. Click the Open button. The study data displays on the AccuCT Main Window.

**NOTE**

Study parameters for an exiting study may be added to the study by importing a .csv or .yaml file. See Importing Study Data on page 30.
Importing Study Data

An alternate method for creating a study or adding data to an existing study is to import study parameters with an a .csv or yaml file.

The following study data may be imported into a new or existing study using the .csv or .yaml file:

- Studies
- Study groups, group descriptions, and group types (optional)
- Animals, species, subspecies, sex, birth dates, and weights
- Scans and workflows used during analysis (see page 35)

The following study data can not be imported with a .csv or .yaml file and must be added manually:

- IACUC Protocol ID, study start date, and imaging agents
- Phantom scans used during analysis (see page 71)

This section includes the following procedures for importing study data:

- Format the File (see page 30)
- Review the File for Errors (see page 33)

Format the File

1. Create a .csv or .yaml file following the formats used in Figure 20 (for studies with study groups) or Figure 21 (for studies without study groups).
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Sparta</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Name</td>
<td>Group A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Description</td>
<td>This is Group A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Type</td>
<td>PositiveControl</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Name</td>
<td>Group B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Description</td>
<td>This is Group B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Type</td>
<td>NegativeControl</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Animals</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Animal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>Group</td>
<td>Group A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Name</td>
<td>Animal 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Species</td>
<td>Cat</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Subspecies</td>
<td>Outbred Tabby</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Sex</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>BirthDate</td>
<td>7-Jul-16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Weight</td>
<td>9.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Animal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>Group</td>
<td>Group B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Name</td>
<td>Animal 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Species</td>
<td>Dog</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Subspecies</td>
<td>Beagle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Sex</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>BirthDate</td>
<td>17-Jun-15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Weight</td>
<td>7.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>ScanData</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Scan</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>AnimalName</td>
<td>Animal 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>ScanName</td>
<td>Scan Alpha</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>SourcePath</td>
<td>20 micron.VOX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Type</td>
<td>VOX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Scan</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>AnimalName</td>
<td>Animal 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>SourcePath</td>
<td>C:\MicroCT\Data\Ab_DICOM_Data\10Micron</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Type</td>
<td>VOX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Workflows</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>ScanName</td>
<td>Scan Alpha</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>WorkflowName</td>
<td>Workflow Delta</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Type</td>
<td>AsmrWorkflow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>WorkflowName</td>
<td>Workflow Epsilon</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Type</td>
<td>SingleBoneBoneMineralDensityWorkflow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>WorkflowName</td>
<td>Workflow Gamma</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Type</td>
<td>WholeScanBoneMineralDensityWorkflow</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 20. File Format for Import with Study Groups**
NOTE

If the sourcepath for a scan includes only the name of the .vox file or DICOM folder, and not a full path to a location, the AccuCT software will look for the file or folder within the local directory.

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Dana</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Animals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Animal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Name</td>
<td>Animal 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Species</td>
<td>Cat</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Subspecies</td>
<td>Outbred Tabby</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sex</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>BirthDate</td>
<td>7-Jul-16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Weight</td>
<td>9.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Animal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Name</td>
<td>Animal 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Species</td>
<td>Dog</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Subspecies</td>
<td>Beagle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Sex</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>BirthDate</td>
<td>17-Jun-15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Weight</td>
<td>7.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>ScanData</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Scan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>AnimalName</td>
<td>Animal 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>ScanName</td>
<td>Scan Alpha</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>SourcePath</td>
<td>20 micron.VOX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Type</td>
<td>VOX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Scan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>AnimalName</td>
<td>Animal 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>SourcePath</td>
<td>C:\MicroCT\Data\Ais\DICOM_Data\10 Micron</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Type</td>
<td>VOX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Workflows</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>ScanName</td>
<td>Scan Alpha</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>WorkflowName</td>
<td>Workflow Delta</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Type</td>
<td>Asbm\Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>WorkflowName</td>
<td>Workflow Epsilon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Type</td>
<td>SingleBoneBoneMineralDensityWorkflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Workflow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>ScanName</td>
<td>Scan Beta</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>WorkflowName</td>
<td>Workflow Gamma</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 21. File Format for Import without Study Groups
Format the File (Continued)

2 Select **File → Import Study** from the **Menu Bar**. The **Select Study to Import Window** opens.

3 Navigate to the .csv or .yaml file to be imported and click the **Open** button.

**NOTES**

- If the study name in the .csv or .yaml file matches the name of the currently opened study, the imported data displays on the **Animals & Data Tab**.
- If the study name in the .csv or .yaml file matches an existing study name that is not currently opened, the data is imported into the study, but the study is not opened automatically.
- If the study name in the .csv or .yaml file does **not** match an opened or existing study, the data is imported into a new study, but the study is not opened automatically.

Review the File for Errors

If a fatal error occurs or the import fails, review the .csv or .yaml file for the following formatting errors and correct the information in the file:

1 **Empty Fields** for the same parameter. See **Figure 22**.

   ![Figure 22. Empty Field for the Same Parameter](image)

2 **Duplicate Fields** for same parameter (see **Figure 23**).
3 Invalid Field Format. See Figure 24.

4 Inconsistent fields between existing study parameters and imported study parameters. See Figure 25.
Data Analysis

After study parameters are defined, the AccuCT software can perform data analysis with step-by-step workflows for specific applications and measurement outcomes. The available workflows are ASBMR Morphometry, Whole Scan BMD, Single Bone BMD, Bone Growth, Bone Loss, and Calibrate BMD.

NOTE

ROIs (Regions of Interest) can be applied to all workflows except for the Calibrate BMD Workflow.

This section contains the following procedures for performing data analysis workflows:

- Understanding Workflows (see page 36)
- Associating Scan Data (see page 38)
- Viewing the Scan Data (see page 40)
- Adjusting the Scan Data Properties (see page 43)
- Changing the HU Calibration (see page 49)
- Performing the ASBMR Morphometry Workflow (see page 50)
- Performing the Calibrate BMD Workflow (see page 68)
- Performing Whole Scan BMD and Single Bone BMD Workflows (see page 74)
- Performing the Bone Growth and Bone Loss Workflows (see page 80)
- Exporting the Measurement Results (see page 83)
- Opening an Existing Workflow (see page 83)
- Renaming a Workflow (see page 84)
Understanding Workflows

The ASBMR Morphometry, Whole Scan BMD, Single Bone BMD, Bone Growth, Bone Loss, and Calibrate BMD workflows consist of a series of steps. Each step is performed with input and output parameters. The results of one step serves as the input for the next step. When all steps complete, the results of the workflow display.

Workflow Steps

When a workflow starts, the first step in the workflow displays in a step box on the left side of the Workflow Viewer Tab. The workflow name displays vertically on the far left side on the tab. See Figure 26.

![Figure 26. Workflow Viewer Tab](image)

Each step is computed with parameters displayed in the Step Settings Tab. If desired, the parameters can be adjusted.

The status of each step is displayed as circles on the right side of the step box. See Table 1 for descriptions of the status.

<table>
<thead>
<tr>
<th>Status Circle Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Step was successfully computed.</td>
</tr>
<tr>
<td>Hollow Green</td>
<td>Step is enabled and can be performed.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Step settings have changed since the last time the step computed successfully.</td>
</tr>
<tr>
<td>Rotating, Blue</td>
<td>Step computation in process.</td>
</tr>
<tr>
<td>Red</td>
<td>Step computation failed. Step can be recomputed using different step settings to attempt to correct the problem.</td>
</tr>
</tbody>
</table>
Recomputing a Step

If changes to a step result are desired, the step can be recomputed.

To recompute a step:

1. Click the box of the step to be recomputed on the Workflow Viewer Tab.
2. Click the **Inputs** button on the step box. See Figure 27.

![Figure 27. Click the Inputs button](image)

3. Click the **Step Settings Tab**.
4. Click the **Reset** button on the top right side of the **Step Settings Tab** to return the step settings to their default values.

   **OR**

   Change the options on the **Step Settings Tab** as desired.

5. Click the **Compute** button on the box of the step to be recomputed on the Workflow Viewer Tab. The AccuCT software recomputes the step.

Completed Workflows

When a workflow completes successfully, the completed steps display on the Workflow Viewer Tab. See Figure 28.

![Figure 28. Completed Workflow](image)
Associating Scan Data

Before starting ASBMR Morphometry, Whole Scan BMD, Single Bone BMD, Bone Growth, or Bone Loss workflows, scan data must be associated with an animal on the Animals & Data Tab.

NOTE

Unlike other workflows, Calibrate BMD Workflows start by associating phantom scan data to a phantom types on the Calibration Data Tab. See page 69 for more information.

The AccuCT software supports the following scan data formats:
- VOX files
- DICOM folders

To associate scan data to an animal in a study:

1. Click the Animals & Data Tab on an opened study.
2. On the Menu Bar, select **File → Load Scan Data**
   OR
   Right-click the animal to associate scan data with and select **Import Data**. The Import Data Window opens.
3. Select **Add Files** from the Add Files button drop-down list on the Import Data Window to associate a VOX file or multi-frame DICOM file with an animal in the study.
   OR
   Select **Add DICOM Folder** from the Add Files button drop-down list to associate a DICOM folder with an animal in the study.
4. Browse to the desired file/folder, select the file/folder, and click the **Open** button. The selected file or folder name displays in **File(s)** text box on the Import Data Window.
5. Click the **Associate With** button and select the animal to assign scan data to from the drop-down list.
Associating Scan Data (Continued)

NOTE

![If the Import Data Window was opened by right-clicking an animal in the study, this step is not necessary. The file or folder is automatically associated with the animal that was right-clicked.]

6 Click the Import button. An arrow displays next to the animal on the Animals & Data Tab.

7 Click the arrow to view the scan name associated with the animal. See Figure 29.

![Figure 29. VOX File Associated with Mouse 1]

8 To assign additional scan data to animals in the study, repeat step 1 to step 7.

NOTE

![The AccuCT software allows you to assign multiple scans to each animal, but will prevent you from assigning the same scan to the same animal times.]

Viewing the Scan Data

When a workflow begins, the raw scan data displays on the four panels of the 3D Visualization Tab. See Figure 30.

This section includes the following procedures to adjust the views of the four panels on the 3D Visualization Tab and how to export the image of the scan (if desired). These options do not change the raw data but provide different means of displaying the data.

- Zoom In (see page 41)
- Zoom Out (see page 41)
- Pan (see page 41)
- Rotate (see page 41)
- Reset (see page 42)
- Export (see page 42)
**Zoom In**

**To zoom in on a 3D image:**
- Click the image and move the trackball/scroll wheel downward.
  OR
- Press CTRL + Shift + click the image, and drag the mouse downward.

**To zoom in on a 2D slice image:**
- Click the image with the trackball/scroll wheel and move the trackball/scroll wheel downward.

**Zoom Out**

**To zoom out from a 3D image:**
- Click the image and move the trackball/scroll wheel upward.
  OR
- Press CTRL + Shift + click the image, and drag the mouse upward.

**To zoom in on a 2D slice image:**
- Click the image with the trackball/scroll wheel and move the trackball/scroll wheel upward.

**Pan**

**To pan a 3D image:**
- Click the image with the trackball/scroll wheel + drag the image in any direction.
- Press Shift + click + drag the image in any direction.

**To pan a 2D image:**
- Click the image with the trackball/scroll wheel + drag the image in any direction.

**Rotate**

To rotate the image (from the 3D display only):
- Click the image + move the mouse to the desired angle of rotation.
Reset

If desired, the view of the panels on the 3D Visualization Tab may be reset to their default settings by clicking the Reset Views button on top of the tab.

Export

If desired, the current rendered 3D panel image in the 3D Visualization Tab may be exported as an image file. To export the image:

1. Click the Export drop-down list.
2. Select Screen Resolution to save the image at current screen resolution.
   OR
   Select High Resolution to save the image at a 600 dpi resolution.
3. Select .png, .bmp, .jpg, or .tif file from the Save at type drop-down list. The file is saved as the selected image file type.
Adjusting the Scan Data Properties

The properties of the scan data that display on the 3D Visualization Tab may be adjusted on the Visualization Settings Tab. Any changes made on the Visualization Settings Tab are then displayed on the 3D Visualization Tab. These options do not change the raw scan but provide different means of displaying the scan.

This section describes how the following visualization settings can be adjusted throughout a workflow:

- Window and Level (see page 44)
- Colormap (see page 46)
- 2D Display (see page 47)
- 3D Display (see page 48)
- Invert (see page 48)
- Reset Settings (see page 49)
Window and Level

The **window** is the range of Hounsfield units displayed on the 3D Visualization Tab. Larger windows display larger ranges of tissue density on the 3D Visualization Tab. Smaller windows display smaller ranges of tissue density.

The **level** is the Hounsfield number in the center of the window.

A **histogram** displays on top of the Visualization Settings Tab to reflect the distribution of voxel intensities in the 3D image as a function of HU. The histogram is display only and cannot be manually adjusted.

**NOTE**

*When the window number is changed, the histogram changes to reflect the new window number.*

To adjust the window or level number:

1. Type the desired number into the **Window** or **Level** numeric text box on the Visualization Settings Tab

   OR

2. Use the arrows to increase or decrease the Window or Level number.
When the window or level numbers are adjusted, the panel views on the 3D Visualization Tab display the updated numbers. Figure 31, Figure 32, and Figure 33 show examples of different window numbers.

Figure 31. Window = 1,000 HU

Figure 32. Window = 2,000 HU
The colormap of the 3D image can be adjusted from its default color. The **volren red** and **volume render white** color maps are more suitable for most visualization of raw scan data. Other colormaps can be useful to bring out subtle differences in tissue density, especially in the 2D slice panels.

To change the colormap:

1. Click the **Colormap** drop-down list on the **Visualization Settings Tab**.

2. Select the desired colormap. **Figure 34** and **Figure 35** show examples of different colormaps.
2D Display

If desired, the 2D slice visualization settings can be adjusted on the Visualization Settings Tab when a step has been computed.

To adjust the 2D slice visual settings:

- Select the **Raw Slices** check box to display the raw scan data of the slices.
- Select the **Computed Slices** check box to display the processed scan data of the slices.
- Select the **Raw Slices** check box and the **Computed Slices** check box to display the computed slice inside the raw slice.
• Move the **Transparency** slider closer to 1 to increase the bone transparency on the 2D slices. Move the slider closer to 0 to decrease the bone transparency on the 2D slices.

• Type a number of voxels into the **X-Slice** numeric text box or move the arrow up or down to change the location of the X slice.

• Type a number of voxels into the **Y-Slice** numeric text box or move the arrow up or down to change the location of the Y slice.

• Type a number of voxels into the **Z-Slice** numeric text box or move the arrow up or down to change the location of the Z slice.

### 3D Display

If desired, the 3D display visualization settings can be adjusted on the **Visualization Settings Tab**. To adjust the 3D display visualization settings:

• Select the **Raw Data** check box to display the raw scan data on the 3D display panel.

• Select the **Computed Volume** check box to display the results of a step computation on the 3D display panel.

• Select the **Raw Data** check box and the **Computed Volume** check box to display the results of a step computation inside the raw data scan on the 3D display panel.

### Invert

If the scan is not properly oriented, the scan can be inverted.

To invert the scan:

1. Click the downward arrow on the bottom of the **Visualization Settings Tab**. The **2D and 3D Display** check boxes display.

2. Select the **Invert X** check box to invert the scan along the x-axis.

3. Select the **Invert Z** check box to invert the scan along the y-axis.

4. Select the **Invert Z** check box to invert the scan along the z-axis.

**NOTE**

*When an axis is inverted, the slice numbers go from high to low in the direction of the axis coordinate arrows, rather than the default of increasing slice numbers along each axis.*
Reset Settings

To return the Window and Level settings to their default values, click the **Reset button** on top right of the **Visualization Settings Tab**.

**NOTE**

*The colormap, slice numbers, and axis inversion settings are **NOT** affected by the Reset button.*

Changing the HU Calibration

If the microCT instrument used to capture scans is mis-calibrated, the AccuCT software can adjust how the raw grayscale values in the scan are converted to Hounsfields Units.

To change the HU calibration on scan:

1. Right-click the scan name on the **Animals & Data Tab** and select **Change HU Calibration** from the context menu. The **Change HU Calibration Window** opens.

2. Type the desired **Slope** and **Intercept** values into the numeric text boxes or use the arrow keys until the desired value is reached.

3. Click the **OK** button.

4. To view the changes to the slope and intercept, double-click the scan name on the **Animals & Data Tab**. The updated scan displays on the **3D Visualization Tab**.
Performing the ASBMR Morphometry Workflow

NOTES

• The ASBMR Morphometry algorithms and measurements do not work well for data with voxel sizes larger than approximately 50 um. Analyses performed on such low resolution data may produce unreliable results.

• Some ASBMR Morphometry measurements require the bone being analyzed to be aligned with the Z axis of the data. Computing these measurements with non-axis-aligned data will produce incorrect results. See ASBMR Measurements on page 66.

The ASMBR Morphometry workflow performs ASBMR morphometric analysis associated with cortical and trabecular components of individual bones.

The following procedures may be part of the ASBMR Morphometry workflow:

1 Starting the ASBMR Morphometry Workflow (see page 51)
2 Detect Bones (see page 52)
3 Separate Bones (see page 53)
4 Segment More (see page 55)
5 Join Segments (see page 58)
6 Segment Bone Compartments (see page 60)
7 Define ROI (see page 63)
8 Calculate ASBMR Measurements (see page 66)
Starting the ASMBR Morphometry Workflow

To start the ASBMR Morphometry workflow:

1. Right-click the desired scan on the Animals & Data Tab.
2. Select ASBMR Morphometry from the context menu.

The scan displays on the 3D Visualization Tab.

The Visualization Settings Tab displays.

The Detect Bones step is enabled on the Workflow Viewer Tab. See Figure 37.

![Figure 37. Detect Bones Step Box is Enabled](image)

NOTE

The visualization settings on the Visualization Settings Tab may be adjusted as desired throughout the workflow. See page 43.
Detect Bones

When the AccuCT software performs the Detect Bones step, bone in the scan is identified and separated from surrounding tissue.

To perform the Detect Bones step:

1. Click the **Inputs** button in the **Detect Bones** step box on the **Workflow Viewer Tab**.

2. If desired, the minimum bone size used during the Detect Bones step computation can be adjusted. To adjust the minimum bone size:
   a. Click the **Step Settings Tab** tab.
   b. Click the downward arrow on the **Step Settings Tab**. The **Minimum Bone Size** numeric text box displays.
   c. Type a number of voxels into the Minimum Bone Size numeric text box or move the arrow up or down to compute the Detect Bones step with this new minimum bone size. Any bone below the minimum bone size will not be detected during the Detect Bones step computation.

3. Click the **Compute** button in the Detect Bones step box on the **Workflow Viewer Tab**. The results of the Detect Bones step display on the display on the **AccuCT Main Window**. See **Figure 38**.

![Figure 38. Detect Bones Results](image-url)
Detect Bones (Continued)

4 To view the settings used to compute the step (if desired), click the Detect Bones step box and click the **Results** button. The settings display on the **Step Settings Tab**.

5 To recompute the step with different settings (if desired), see **Recomputing a Step on page 37**.

Separate Bones

When the Separate Bones step is performed, the AccuCT software visually separates the mask bone from non-bone by assigning different colors to each bone segment.

To perform the Separate Bones step:

1 Click the **Inputs** button in the **Separate Bones** step box on the **Workflow Viewer Tab**.

2 Click the **Step Settings Tab**. The default setting for **Sensitivity** displays. This setting will be used during the Separate Bones step computation.

3 If desired, move the **Sensitivity** slider closer to **low** to compute the Separate Bones step with fewer bone segments. Move the slider closer to **high** to compute the step with more bone segments.

4 Click the downward arrow on the **Step Settings Tab** to view the advanced Separate Bones step settings. The default settings for **Pre-Processing Smoothing** and **Minimum Bone Segment Volume** display. These advanced settings will be used during the Separate Bones step computation.

5 If desired, move the **Pre-Processing Smoothing** slider closer to **smooth** to decrease the ability to separate bone segments that are close together. Move the slider closer to **coarse** to increase the ability to separate bone segments that are close together.

If desired, type a new number of voxels into the **Minimum Bone Segment Volume** numeric text box or move the arrow up or down until the desired number of voxels is reached. Any bone segment below the minimum bone segment volume will be merged with the nearest segment above the entered threshold size during the Separate Bones step computation.
Separate Bones (Continued)

6 Click the **Compute** button in the Separate Bones box on the **Workflow Viewer Tab**. The results of the Separate Bones step display on the **AccuCT Main Window**. See Figure 39.

![Figure 39. Separate Bones Step Results](image)

7 To view the settings used to compute the step (if desired), click the Separate Bones step box and click the **Results** button. The settings display on the **Step Settings Tab**.

8 To recompute the step with different settings (if desired), see page 50.
Segment More

Some bones require further segmenting when the Separate Bones step completes. The Segment More step assigns a different color to the different labeled regions of the bone requiring further segmenting.

NOTE

If further segmenting is not needed, click the Join Segments step box and proceed to the Join Segments section on page 58.

To perform the Segment More step:

1. Click the Inputs button in Segment More step box on the Workflow Viewer Tab. The default setting for Sensitivity displays on the Step Settings Tab. This setting will be used during the Segment More step computation.

2. If desired, move the Sensitivity slider closer to low to compute the Segment More step with fewer bone segments. Move the slider closer to high to compute the step with more bone segments.

3. Click the downward arrow on the Step Settings Tab to view the advanced Segment More step settings. The default settings for Pre-Processing Smoothing, Compartment Fragmentation, and Minimum Bone Segment Volume display. These advanced settings will be used during the Segment More step computation.

4. If desired, move the Pre-Processing Smoothing slider closer to smooth to decrease the ability to separate bone segments that are close together. Move the slider closer to coarse to increase the ability to separate bone segments that are close together.

5. If desired, move the Compartment Fragmentation slider closer to more to increase the fragmentation of the trabecular bone. Move the slider closer to less to decrease the fragmentation, creating fewer labels for the cortical and trabecular material within a single bone.
Segment More (Continued)

6 If desired, type in the desired number of voxels into the **Minimum Bone Segment Volume** numeric text box or move the arrow up or down until the desired number of voxels is reached. Any bone segment below the minimum bone segment size will not be segmented during the Segment More step computation.

7 Click the **Pick Bones** button.

8 Hover the mouse cursor over the bone to be segmented on the 3D display of the **3D Visualization Tab**. The bone turns white.

9 Click the bone to be segmented. The bone turns red. See Figure 40.

![Figure 40. Pick Bone to Segment](image)

10 Click the **Done** button.
Segment More (Continued)

11 Click the **Compute** button in the Segment More step box on the **Workflow Viewer Tab**. The results of the Segment More step display on the **AccuCT Main Window**. The selected bone has been further segmented. See **Figure 41**.

![Figure 41. More Segmentation](image)

12 To view the settings used to compute the step (if desired), click the Segment More step box and click the **Results** button. The settings display on the **Step Settings Tab**.

13 To recompute the step with different settings (if desired), see **Recomputing a Step on page 37**.
Join Segments

If too much segmentation occurred during the Separate Bones or Segment More steps, use the Join Segment step to join two or more segments into a single colored label.

NOTE

*If less segmentation is not needed, click the Segment Bone Compartment step box and proceed to the Segment Bone Compartments section (see page 60).*

To perform the Join Segments step:

1. Click the Inputs button in the Join Segments step box on the Workflow Viewer Tab.
2. Click the Pick Bones button on the Step Settings Tab.
3. Hover the mouse cursor over the first bone to be joined on the 3D display of the 3D Visualization Tab. The bone turns white.
4. Shift-click the first bone. The bone turns red. See Figure 42.

![First Bone Selected](image)

**Figure 42. First Bone to be Joined Turns Red**

5. Hover the mouse cursor over the second bone to be joined to the first on the 3D display of the 3D Visualization Tab. The bone turns white.
Join Segments (Continued)

6 Shift -click the second bone to be joined to the first bone. The bone turns red. See Figure 43.

![Second Bone Selected](image)

**Figure 43. Second Bone to be Joined Turns Red**

7 Click the **Done** button on the **Step Settings Tab**.

8 Click the **Compute** button in the Join Segments step box on the **Workflow Viewer Tab**. The results of the Join Segments step display on the **AccuCT Main Window**. See Figure 44.

![Workflow Viewer](image)

**Figure 44. Join Segments Step Results**
Join Segments (Continued)

9 To view the settings used to compute the step (if desired), click the Join Segments step box and click the **Results** button. The settings display on the **Step Settings Tab**.

10 To recompute the step with different settings (if desired), see **Recomputing a Step on page 37**.

Segment Bone Compartments

During the Segment Bone Compartments step, the AccuCT software separates the selected bone into three bone compartments: cortical, trabecular, and marrow.

To perform the Segment Bone Compartments step:

1 Click the **Segment Bone Compartments** step box on the **Workflow Viewer Tab**.

2 Click the downward arrow on the **Step Settings Tab** to view the advanced step settings. The default settings for **Marrow Filling Strength**, **Maximum Cortical Hole Size**, and **Maximum Trabecular Sport Size** display. These settings will be used during the Segment Bone Compartments step computation.

3 If desired, the **Marrow Filling Strength** slider can be moved to compensate for holes and cracks in the cortex, making the morphological filling of the marrow more effective. Move the slider closer to **weak** to decrease the compensation for imperfections in the cortical bone. Move the slider closer to **strong** to increase the compensation.

4 If desired, type a new number into the **Maximum Cortical Hole Size** numeric text box or move the arrow up or down until the desired size is reached. The smaller the maximum cortical hole size, the more likely that large holes in the cortex will result in the marrow inside these holes not being labeled as part of the marrow compartment.

5 If desired, type the desired number of voxels into the **Maximum Trabecular Spot Size** numeric text box or move the arrow up or down until the desired size is reached. The smaller the maximum trabecular spot size, the less bone will be included in the trabecular bone compartment during the step computation.
Segment Bone Compartments (Continued)

6 Click the **Pick Bones** button on the **Step Settings Tab**.

7 Hover the mouse cursor over the bone on the 3D Display of the **3D Visualization Tab** to be separated into the cortical, trabecular, and marrow bone compartment. The bone turns white.

8 Click the bone to be separated into the cortical, trabecular, and marrow bone compartments. The bone turns red. See **Figure 45**.

![Figure 45. Selected Bone Turns Red](image)

9 Click the **Done** button on the **Step Settings Tab**.

10 Click the **Compute** button in the Segment Bone Compartments step box on the **Workflow Viewer Tab**. The results of the Segment Bone Compartments step display on the **AccuCT Main Window** and a shaded ROI box displays around the 3D image. See **Figure 46**.
Segment Bone Compartments (Continued)

11 To better view the three segments, clear the Show ROI check box on the Step Settings Tab. The cortical bone segment displays in brown, the trabecular bone segment displays in green, and the marrow bone segment displays in light green. See Figure 47.
Segment Bone Compartments (Continued)

12 To view the settings used to compute the step (if desired), click the Segment Bone Compartments step box and click the Results button. The settings display on the Step Settings Tab.

13 To recompute the step with different settings (if desired), see Recomputing a Step on page 37.

Define ROI

The Define ROI step allows workflow measurements to be computed for an ROI instead of for the entire bone.

NOTE

If ROIs will NOT be applied to the bone, proceed to the ASBMR Measurements step (see page 66).

To perform the Define ROI step:

1 Adjust the view of the 3D image (see page 40) to best view the ROI. See Figure 48.

2 Click Inputs button in the Define ROI step box on the Workflow Viewer Tab.

3 Click the Step Settings Tab.
Define ROI (Continued)

4 Adjust the ROI step settings on the Step Settings Tab until the ROI is defined by using the following options:

- To move the center of the ROI in the X direction, type a number of voxels into the **X Center** numeric text box or move the arrow up or down.
- To move the center of the ROI in the Y direction, type a number of voxels into the **Y Center** numeric text box or move the arrow up or down.
- To move the center of the ROI in the Z direction, type a number of voxels into the **Z Center** numeric text box or move the arrow up or down.
- To change the size of the ROI in the X direction, type a number of voxels into the **X Size** numeric text box or move the arrow up or down.
- To change the size of the ROI in the Y direction, type a number of voxels into the **Y Size** numeric text box or move the arrow up or down.
- To change the size of the ROI in the Z direction, type a number of voxels into the **Z Size** numeric text box or move the arrow up or down.
- To rotate the ROI to match the orientation of the bone in the X direction, click the **Rotate X** button.
- To rotate the ROI to match the orientation of the bone in the Y direction, click the **Rotate Y** button.
- To rotate the ROI to match the orientation of the bone in the Z direction, click the **Rotate Z** button.

5 Click the **Compute** button in the Define ROI step box on the Workflow Viewer Tab to save the current ROI parameters for use in the remaining steps of the workflow. The results of the Define ROI step display on the AccuCT Main Window. See Figure 49.
Define ROI (Continued)

6 To view the settings used to compute the step (if desired), click the Define ROI step box and click the **Results** button. The settings display on the **Step Settings Tab**.

7 To recompute the step with different settings (if desired), see **Recomputing a Step on page 37**.
ASBMR Measurements

During the ASBMR Measurements step, the AccuCT software computes measurement results for the selected trabecular and the cortical bone compartments.

To perform the ASBMR Measurements step:

1. Click the **ASBMR Measurements** box on the **Workflow Viewer Tab**. The default **Trabecular, Cortical, Overall, and Z-Axis Aligned** measurements options display on the **Step Settings Tab**. These measurements will be computed during the ASBMR Measurement step.

**NOTE**

*The parameters in the “Z-Axis Aligned” sections will only produce valid results for bones that are aligned with the Z axis of the scan.*

2. If desired, the Trabecular, Cortical, Overall, and Z-Axis Aligned measurements to be computed during the ASBMR Measurement step can be changed. To change the measurements, clear the check boxes on the **Step Settings Tab**, and select the desired measurement check boxes.

3. Click the downward arrow on the **Step Settings Tab** to view the advanced ASBMR Measurements settings. The default settings for the advanced **Cortical** and **Z-Axis Aligned** measurements display. These advanced measurements will be computed during the ASBMR Measurement step.

4. If desired, the advanced **Cortical** and **Z-Axis Aligned** measurements can be computed. To compute the measurements, select the desired Cortical and Z-Axis Aligned measurement check boxes.
ASBMR Measurements (Continued)

5 Click the **Compute** button in the ASBMR Measurements step box on the **Workflow Viewer Tab**. The results of the ASBMR Morphometry Workflow display on the **AccuCT Main Window**. The **Measurements Tab** displays a table with the ASBMR measurement results. See Figure 50.

![Figure 50. ASBMR Measurement Workflow Results](image)

6 To view the settings used to compute the step (if desired), click the ASBMR Measurements step box and click the **Results** button. The settings display on the **Step Settings Tab**.

7 To recompute the step with different settings (if desired), see **Recomputing a Step on page 37**.

**NOTE**

If desired the ASMBR Morphometry measurement table may be copied to the clipboard or exported as a .csv file. See **Exporting the Measurement Results on page 83**.
Performing the Calibrate BMD Workflow

The Calibrate BMD Workflow computes the conversion from HU to mg HA / cm$^3$ for a scan of a BMD calibration phantom. These phantoms come in a variety of sizes for use with different scan fields and in different applications.

Complete the following procedures to perform the Calibrate BMD Workflow:

1. Associate BMD Phantom Scan Data (see page 69)
2. Start the Calibrate BMD Workflow (see page 70)
3. Segment BMD Phantom (see page 72)
4. Calibrate BMD Phantom (see page 72)
Associate BMD Phantom Scan Data

Before starting the Calibrate BMD Workflow, phantom scan data must be associated with a BMD phantom type. The AccuCT software supports the following phantom types, which can be purchased from PerkinElmer:

- 32 mm QRM BMD Phantom
- 25mm QRM BMD Phantom
- 20 mm QRM BMD Phantom
- 10 mm QRM BMD Phantom
- 4.5 mm QRM BMD Phantom

To associate scan data to an animal in a study:

1. Click the Calibration Data Tab and click the Import BMD Phantom Data button.
   OR
   Select File → Load BMD Phantom Data from the Menu Bar.
   The Import Phantom Data Window opens.

2. Click the Add Files button from the Import Phantom Data Window to associate a VOX file or multi-frame DICOM file to a phantom type.
   OR
   Select Add DICOM Folder from the Add Files button drop-down list to associate a DICOM folder to a phantom type.

3. Browse to the desired file or folder, select the file or folder, and click the Open button. The selected file or folder name displays in File(s) text box on the Import Phantom Data Window.

4. Click the Phantom Type drop-down list and select the phantom type to be associated with the file or folder.

5. Click the Import button. The Import Phantom Data Window closes and an arrow displays next to the phantom type on the Calibration Data Tab.

6. Click the arrow to view the name of the phantom scan associated to the phantom. See Figure 51.
To associate additional phantom scan data to phantom types, repeat step 1 to step 5.

**Start the Calibrate BMD Workflow**

To start the Calibrate BMD Workflow:

1. Right-click the desired phantom scan on the Calibration Data Tab.

2. Select **BMD Phantom Calibration** from the context menu. The scan displays on the 3D Visualization Tab and the Visualization Settings Tab displays.

   The **Segment BMD Phantom** step is enabled on the Workflow Viewer Tab. See Figure 51.

   ![Figure 52. Segment BMD Phantom Step is Enabled](image)
NOTE

The visualization settings on the Visualization Settings Tab may be adjusted as desired throughout the workflow. See page 43.

Segment BMD Phantom

When the AccuCT software performs the Segment BMD Phantom step, it segments the five rods of different densities from the rest of the scan, creating a labeled mask of each rod.

To perform the Segment BMD Phantom step:

1. Click the Inputs button in the Segment BMD Phantom step box on the Workflow Viewer Tab.

NOTE

No user-definable settings display on the Step Settings Tab during the Segment BMD Phantom step.

2. Click the Compute button. The results of the Segment BMD Phantom step display on the 3D Visualization Tab. See Figure 53.

![Figure 53. Segment BMD Phantom Step Results](image)
Calibrate BMD Phantom

When the AccuCT software performs the Calibrate BMD Phantom step, it measures the HU values in each segmented rod and performs a linear regression of the specified densities (in mg HA/cm³) with the measured values. This produces a calibration curve that subsequently can be applied to animal scans for BMD measurements.

To perform the Calibrate BMD Phantom step:

1. Click the **Inputs** button in the **Calibrate BMD Phantom** step box on the **Workflow Viewer Tab**.

2. Click the **Step Settings Tab** to change the settings for **Rod Densities**. The default settings are the correct settings for newly purchased BMD calibration phantoms. For phantoms that contain rods with different densities, adjust the settings accordingly.

3. Click the **Compute** button in the Calibrate BMD Phantom step box on the **Workflow Viewer Tab**. The results of the Calibrate BMD Workflow display on the **Plots Tab**. The plot displays the linear regression of the specified densities (in mg HA/cm³) with the measured HU values and displays a calibration curve. See **Figure 54**.

![Figure 54. Calibrate BMD Phantom Workflow Results](image)
Calibrate BMD Phantom (Continued)

4 To view the measured values computed in this step, move your mouse cursor over the points in the plot. An overlay on the plot displays with the values of that point. See Figure 55.

Figure 55. Overlay on the Plot

5 To view the settings used to compute the step (if desired), click the Calibrate BMD Phantom step box and click the Results button. The settings display on the Step Settings Tab.

6 To recompute the step with different settings (if desired), see Recomputing a Step on page 37.
Performing Whole Scan BMD and Single Bone BMD Workflows

NOTE

A Calibrate BMD Workflow must be completed before performing a BMD Workflow. See page 68.

The AccuCT software can perform Whole Scan BMD and Single Bone BMD workflows to measure bone mineral density in all bones in the scan or a single selected bone, respectively. This section describes the steps to perform both BMD workflows. Any differences between the two workflows will be noted throughout.

Complete the following procedures to perform a BMD Workflow:

1. Associate a Calibrate BMD Workflow to Scan Data (see page 75)
2. Starting the BMD Workflow (see page 76)
3. Detect Bones (see page 76)
4. Separate Bones (see page 76)
5. Segment More (see page 77)
6. Join Segments (see page 77)
7. Define ROI (see page 77)
8. Calculate BMD Measurements (see page 78)
Associate a Calibrate BMD Workflow to Scan Data

Before starting a BMD Workflow, a completed BMD Calibration Workflow must be associated to scan data.

To associate a completed BMD Calibration Workflow to scan data:

1. Right-click the data scan file associated with an animal on the Animals & Data Tab.
2. Select Associate BMD calibration from the context menu. The Choose Calibration Scan Window opens.

NOTE

If This study has no calibration displays on the Choose Calibration Scan Window, a Calibrate BMD Workflow has not been completed. See page 68.

3. Click the completed Calibrate BMD workflow to associate with the scan.

4. Click the OK button. The Choose Calibration Scan Window closes and the Animals & Data Tab displays a green C next to the calibrated scan. See Figure 56.

Figure 56. Calibrated Scan
Starting the BMD Workflow

To start a BMD Workflow:

1. Right-click the desired calibrated scan on the Animals & Data Tab.

2. Select **Whole Scan BMD** OR **Single Bone BMD** from the context menu. The Detect Bones step box displays on the left side of the Workflow Viewer Tab.

**NOTE**

_The visualization settings on the Visualization Settings Tab may be adjusted as desired throughout the workflow. See page 43._

Detect Bones

When the AccuCT software performs the Detect Bones step, bone in the scan is identified and separated from surrounding tissue.

To perform the Detect Bones step, see Detect Bones on page 52.

**NOTE**

_The next step for Whole Scan BMD workflows is Define ROI. Skip to page 77._

Separate Bones

**NOTE**

_The Separate Bones Step is for Single Bone BMD Workflows only._

When the Separate Bones step is performed, the AccuCT software visually separates the mask bone from non-bone by assigning different colors to each bone segment.

To perform the Separate Bones step, see Separate Bones on page 53.
Segment More

NOTE

The Segment More Step is for Single Bone BMD Workflows only.

Some bones require further segmenting when the Separate Bones step completes. The Segment More step assigns a different color to the different labeled regions of the bone requiring further segmenting.

To perform the Segment More step, see Segment More on page 55.

NOTE

If further segmenting is not needed, click the Join Segments step box and proceed to the Join Segments section below.

Join Segments

NOTE

The Join Segments Step is for Single Bone BMD Workflows only.

If too much segmentation occurred during the Separate Bones or Segment More steps, use the Join Segment step to compute less segmentation.

NOTE

If less segmentation is not needed, click the Define ROI step box and proceed to the Define ROI section below.

To perform the Join Segments step, see Join Segments on page 58.

Define ROI

If an ROI will be applied for either Single Bone or Whole Scan BMD workflows, perform the Define ROI step. See Define ROI on page 63.
BMD Measurements

NOTE

If desired, the BMD measurement results table for Whole Scan BMD or Single Bone BMD Workflows may be copied to the clipboard or exported as a .csv file. See Exporting the Measurement Results on page 83.

The BMD Measurements step is different for the Whole Scan BMD and Single Bone BMD workflows.

Whole Scan BMD Workflows

To perform the BMD Measurements step for Whole Scan BMD Workflows:

1. Click the Inputs button in the BMD Measurements step box on the Workflow Viewer Tab.

NOTE

No user-definable settings display on Step Settings Tab during the BMD Measurement step.

2. Click the Compute button in the BMD Measurements step box on the Workflow Viewer Tab. When the computation is complete, the Measurements Tab displays a table with BMD mean and BMD standard deviation measurements. See Figure 57.

Single Bone BMD Workflows

To perform the BMD Measurements step for Single Bone BMD Workflows:
1 Click the **Inputs** button in the BMD Measurements step box on the **Workflow Viewer Tab**.

2 Click the **Pick Bones** button on the **Step Settings Tab**.

3 Hover the mouse cursor over the bone whose properties will be measured. The bone turns white.

4 Click the bone whose properties are to be measured. The bone turns red.

5 Click the **Done** button on the **Step Settings Tab**.

**NOTE**

_No user-definable settings display on Step Settings Tab during the BMD Measurement step._

6 Click the **Compute** button in the BMD Measurements step box on the **Workflow Viewer Tab**. When the computation is complete, the **Measurements Tab** displays a table with BMD mean and BMD standard deviation measurements. See **Figure 57**.
Performing the Bone Growth and Bone Loss Workflows

The AccuCT software can perform Bone Growth and Bone Loss workflows. These workflows measure bone volume and bone mineral density. The most common application of either workflow is to measure individual time points in a longitudinal study.

This section describes the steps to perform both workflows. Any differences between the Bone Growth and Bone Loss workflows will be noted throughout.

Complete the following procedures to perform a Bone Growth or Bone Loss Workflow:

1. Starting the Bone Growth or Bone Loss Workflow (see page 81)
2. Detect Bones (see page 81)
3. Separate Bones (see page 81)
4. Segment More (see page 81)
5. Join Segments (see page 82)
6. Define ROI (see page 82)
7. Compute Bone Growth and Bone Loss Measurements (see page 82)
Starting the Bone Growth or Bone Loss Workflow

To start a Bone Growth or Bone Loss Workflow:

1. Double-click the desired scan on the Animals & Data Tab. The selected scan name displays on the 3D Visualization Tab and the Visualization Settings Tab opens.

2. Select Bone Growth or Bone Loss from the context menu. The scan displays on the 3D Visualization Tab. The Visualization Settings Tab displays. The Detect Bones step is enabled on the Workflow Viewer Tab.

NOTE

The visualization settings on the Visualization Settings Tab may be adjusted as desired throughout the workflow.

Detect Bones

When the AccuCT software performs the Detect Bones step, bone in the scan is identified and separated from surrounding tissue.

To perform the Detect Bones step, see Detect Bones on page 52.

Separate Bones

When the Separate Bones step is performed, the AccuCT software visually separates the mask bone from non-bone by assigning different colors to each bone segment.

To perform the Separate Bones step, see Separate Bones on page 53.

Segment More

Some bones require further segmenting when the Separate Bones step completes. The Segment More step assigns a different color to the different labeled regions of the bone requiring further segmenting.

To perform the Segment More step, see Segment More on page 55.

NOTE

If further segmenting is not needed, click the Join Segments step box and proceed to the Join Segments section below.
Join Segments

If too much segmentation occurred during the Separate Bones or Segment More steps, use the Join Segment step to compute less segmentation.

**NOTE**

*If less segmentation is not needed, click the Define ROI step box and proceed to the Define ROI section below.*

To perform the Join Segments step, see Join Segments on page 58.

Define ROI

If an ROI will be applied for either Single Bone or Whole Scan BMD workflows, perform the Define ROI step. See Define ROI on page 63.

Bone Growth and Bone Loss Measurements

To perform the Bone Growth or Bone Loss Measurements step:

1. Click the Inputs button in the Bone Growth Measurements or Bone Loss Measurements step box on the Workflow Viewer Tab.

2. Click the Pick Bones button on the Step Settings Tab.

3. Click the whose bone growth or bone loss properties are to be measured. The bone turns red.

4. Click the Done button on the Step Settings Tab.

5. Click the Compute button. When the computation is complete, the Measurements Tab displays a table with total bone volume, BMD mean, and BMD standard deviation measurements.

**NOTE**

*If desired the Bone Growth or Bone Loss measurement table may be copied to the clipboard or exported as a .csv file. See Exporting the Measurement Results on page 83.*
Exporting the Measurement Results

The table on the Measurements Tab can be copied to the Microsoft Windows Clipboard, or exported as Microsoft Excel file or .csv file.

To copy the Measurements Tab table to the Clipboard:

1. Click the Copy button above the table on the Measurements Tab. The applicable information is copied to the Clipboard.
2. Paste the row into a text editing or a spreadsheet program and save the file.

To export the Measurements Tab table as an Excel worksheet or .csv file:

1. Click the Export button above the table on the Measurements Tab. The Export Measurements window opens.
2. Navigate to the desired folder.
3. Type a name into the File name text box.
4. Select Comma-Separated Value or Excel Worksheet from the Save as type drop-down list.
5. Click the Save button. The table is saved in the chosen file format.

Opening an Existing Workflow

To open an existing ASBMR Morphometry, Whole Scan BMD, Single Bone BMD, Bone Growth or Bone Loss Workflow:

1. Open the study (see page 29) containing the workflow to be opened and click the Animals & Data Tab
2. Click the Study folder (if applicable).
3. Click the arrow next to the animal analyzed in the workflow.
4. Click the scan associated with the animal in the workflow.
5. Double-click the desired workflow. The workflow displays on the AccuCT Main Window and opens at the last completed step. If a green circle displays next to a workflow name, the workflow has successfully completed. See Figure 58.
Figure 58. Workflow on Animal & Data Tab

To open an existing Calibrate BMD Workflow:

1. Click the Calibration Data Tab.
2. Click the arrow next to the phantom type.
3. Click the arrow next to the scan associated with the phantom type.
4. Double-click the desired workflow. The workflow displays on the AccuCT Main Window and opens at the last completed step. If a green circle displays next to a workflow name, the workflow has successfully completed. See Figure 59.

Figure 59. Workflow Calibration Data Tab

Renaming a Workflow

To rename a workflow:

1. Right-click on a workflow name on the Animals & Data Tab or the Calibration Data Tab and select Rename from the context menu.
2. Type the new workflow name over the current workflow name on the Rename window.
3. Click the OK button. The renamed workflow displays on the Animals & Data Tab or the Calibration Data Tab.
Software Reference

This section describes the windows in the AccuCT software. Each topic describes the buttons, options, and other controls for each window and how to open the window. This section includes:

- AccuCT Main Window on page 86
- About Window on page 102
- Add Groups Window on page 103
- Change HU Calibration Window on page 104
- Choose Calibration Scan Window on page 105
- Import Data Window on page 106
- Import Phantom Data Window on page 107
- Manage Animals Window on page 108
- New Study Window on page 110
- Open Study Window on page 111
- Restore Animals to Study Window on page 112
- Select Agents Window on page 113
**AccuCT Main Window**

Use the AccuCT Main Window to access all controls for the AccuCT software. To open the Main Window, double-click the AccuCT icon on the desktop.

![Figure 60. AccuCT Main Window](image)

The AccuCT main window contains the following menus and tabs:

- **Menu Bar on page 87**
- **Animals & Data Tab on page 88**
- **Calibration Data Tab on page 89**
- **Study Info Tab on page 91**
- **3D Visualization Tab on page 92**
- **Measurements Tab on page 93**
- **Plots Tab on page 94**
- **Step Settings Tab on page 95**
- **Visualization Settings Tab on page 98**
- **Workflow Viewer Tab on page 100**
Menu Bar

Use the menu bar to access a list of basic commands and menus. The menu bar displays on the top left side of the AccuCT Main Window.

The menu bar contains the following menus:
- File Menu
- Help Menu

File Menu

The File menu contains the following commands:

- **New Study** - Opens the New Study Window to name and create a study.
- **Open Study** - Opens the Open Study Window to open an existing study.
- **Delete Study** - Permanently deletes all data and analyses in the currently loaded study. The deletion cannot be undone.
- **Close Study** - Closes the currently loaded study.
- **Load Scan Data** - Opens the Import Data Window to select the scan data (VOX file, multi-frame DICOM file, or DICOM folder) to associate with an animal in a study.
- **Load BMD Phantom Data** - Opens the Import Phantom Data Window to associate scan data to a phantom type.
- **Import Study** - Opens a Select Study to Import window to locate and open the .csv or .yaml file to use as study parameters for a new or existing study.
- **Exit** - Closes the AccuCT software.

Help Menu

The Help menu contains the following options:

- **About** - Opens the About Window to view information about the AccuCT software.
Animals & Data Tab

The Animals & Data Tab displays on the left side of the AccuCT Main Window. Use the Animals & Data Tab to view the names of studies, study groups, animals, imported scan data, and workflows. The Animals & Data Tab also includes drop-down menus.

The Animals & Data Tab contains the following options:

**Animal** - The name assigned to the animal on the Manage Animals Window.

**Animal Context Menu** - Right-click the animal name to open the context menu to display the following options:
- **Import Data** - Opens the Import Data Window to associate a scan to the selected animal.
- **Rename** - Opens the Rename Animal window to type a new name for the selected animal.
- **Delete** - Deletes the selected animal from the study.

**Scan Data** - The scan data associated with an animal in the study. A green C next to the scan data indicates a calibrated scan.

**Scan Data Context Menu** - Right-click the scan data name to open the context menu to display the following options:
- **Associate BMD Calibration** - Opens the Choose Calibration Scan Window to associate scan data to a completed Calibrate BMD workflow.
- **Change HU Calibration** - Opens the Change HU Calibration Window to change the slope and intercept of the scan data.
Animals & Data Tab (Continued)

- **ASBMR Morphometry** - Starts the ASBMR Morphometry workflow.
- **Whole Scan BMD** - Starts the Whole Scan BMD workflow.
- **Single Bone BMD** - Starts the Single Bone BMD workflow.
- **Bone Growth** - Starts the Bone Growth workflow.
- **Bone Loss** - Starts the Bone Loss workflow.
- **Rename** - Opens the Rename Scan window to type a new name for the selected scan.
- **Delete** - Deletes the selected scan.

**Study** - The name associated with the study on the New Study Window.

**Study Group** - The name assigned to a study group on the Add Groups Window and the number of animals in the study (if applicable).

**Workflow** - A green circle next to a workflow name indicates a completed workflow. A workflow name without a green circle indicates that a workflow is in progress.

**Workflow Context Menu** - Right-click the workflow name to open the context menu to display the following options:
- **Rename** - Opens the Rename Workflow window to type a new name for the selected workflow.
- **Delete** - Deletes the selected workflow.

**Calibration Data Tab**

The Calibration Tab displays on the left side of the AccuCT Main Window. Use the Calibration Tab to view the names of studies, study phantom types, phantom scan, and workflows. The Calibration Tab also includes drop-down menus.

**NOTE**

The Calibration tab is used for Calibrate BMD Workflows only.
Calibration Data Tab (Continued)

![Calibration Data Tab](image)

**Figure 62. Calibration Data Tab**

The Calibration Data Tab contains the following options:

**Study** - The study or study group name.

**Phantom Type** - The phantom type (32 mm QRM BMD Phantom, 25mm QRM BMD Phantom, 20 mm QRM BMD Phantom, 10 mm QRM BMD Phantom, or 4.5 mm QRM BMD Phantom) associated with the scan data.

**Phantom Type Context Menu** - Right-click the phantom type name and select **Import Data** to open the **Import Phantom Data Window** to import a phantom type and scan data.

**Phantom Scan** - The scan associated with phantom type.

**Phantom Scan Context Menu** - Right-click the phantom scan name to open the phantom scan context menu to display the following options:

- **Rename** - Opens the **Rename Phantom Scan window** to type a new name for the selected phantom scan.
- **Delete** - Deletes the selected phantom scan.
- **BMD Phantom Calibration** - Starts a Calibrate BMD Workflow.

**Workflow** - A green circle next to a workflow name indicates a completed workflow. A workflow name without a green circle indicates that a workflow is in progress.

**Workflow Context Menu** - Right-click the workflow name to open the workflow context menu to display the following options:

- **Rename** - Opens the **Rename Workflow window** to type a new name for the workflow.
- **Delete** - Deletes the selected workflow.
Study Info Tab

The Study Info Tab displays on the left side of the AccuCT Main Window. Use the Study Info Tab to define the properties of the study.

The following options display on the Study Info Tab:

**Study Name** - The title of the study.

**Enter a study description** text box - The description of the study.

**IACUC Protocol ID** text box - Your approved Institutional Animal Care and Use Committees protocol ID number.

**Animal Model** text box - The human condition applied to the animals in the study.

**Start Date** text box - The start date of the study.

**Add an agent** button - Opens the Select Agents Window to select a Modality type and the agents used in the study (optional).

**Add a study group** button - Opens the Add Groups Window to assign a study group to the current study.

**Add or edit animals** button - Opens the Manage Animals Window to name animals, add animals, or edit animals in the study.
3D Visualization Tab

The 3D Visualization Tab displays in the middle of the AccuCT Main Window. Use the 3D Visualization Tab to view the x slice, y slice, z slice, and 3D views of scan data. The tab is also used to reset and export the current view of the tab.

The following options display on the 3D Visualization Tab:

**Export** button drop-down list - Saves the current rendered image as a png, .bmp, .jpg, or .tif file. Select **Screen Resolution** to save the image at the current screen resolution. Select **High Resolution** to save the image at a 600 dpi resolution.

**Reset Views** button - Returns the view of the 3D Visualization Tab to its default view, including orientation, zoom level, and center location on all four panels.

**X Slice Display** - Displays a 2D view of a slice of the scan in the Y-Z plane. The slice numbers move along the X axis.

**Y Slice Display** - Displays a 2D view of a slice of the scan in the X-Z plane. The slice numbers move along the Y axis.

**Z Slice Display** - Displays a 2D view of a slice of the scan in the X-Y plane. The slice numbers move along the Z axis.

**3D Display** - Displays a 3D volume rendering of the scan.
Measurements Tab

The Measurement Tab displays in the center of the AccuCT Main Window. The tab displays the measurement results of ASBMR Morphometry, Whole Scan BMD, Single Bone BMD, Bone Growth, and Bone Loss workflows.

![Figure 65. Measurement Tab](image)

The Measurements Tab contains the following options:

**Copy** button - Copies the information in the measurement table to the clipboard.

**Export** button - Opens a *Save As* window to save the measurement table as a Microsoft Excel worksheet or .csv file.

**Measurement** column - The measurements selected on the Step Settings Tab for the final workflow computation.

**Value** column - The numeric results of the measurements selected on the Step Settings Tab for final workflow computation.

**Units** column - The units associated with the values computed during the final workflow step.
Plots Tab

The Plots Tab displays the plot data results of Calibrate BMD Workflows.

Figure 66. Plots Tab

The Plot Tab displays the following information:

**Plot** - Displays the linear regression of the specified densities (in mg HA / cm³) with the measured HU values and displays a calibration curve.

**Plot Overlay** - Move the mouse cursor over a point in the plot to display the measured value of that point.
Step Settings Tab

The Step Settings Tab specifies the analysis parameters to compute during a step in the workflow. To enable the Step Settings tab for each workflow step, click the Inputs button in the step box on the Workflow Viewer Tab and click the tab. When the Step Settings Tab is enabled, the default settings for the current step display.

![Segment More Step Settings Tab](image)

**Figure 67. Segment More Step Settings Tab**

**NOTES**

Click the downward arrow on the Step Settings Tab to display advanced step settings.

The options displayed on the Step Setting Tab change for each workflow step. The Step Setting Tab may contain the following options depending on the active workflow step:

- **Compartment Fragmentation** slider - Move the slider closer to more to increase the fragmentation of the trabecular bone. Move the slider closer to less to decrease the fragmentation, creating a single label for all cortical and trabecular material within a single bone.

- **Cortical** check boxes - Computes the selected cortical bone measurements during the ASBMR Measurements step.
Step Settings Tab (Continued)

**Marrow Filling Strength** slider - Move the slider closer to **weak** to decrease the size of the marrow bone compartment during the Segment Bone Compartments step. Move the slider closer to **strong** to increase the size of the marrow bone compartment during the step computation.

**Maximum Cortical Hole Size** numeric text box - Sets the maximum cortical hole size in voxels during the Segment Bone Compartments step. The smaller the maximum cortical hole size, the more bone will be included in the cortical bone compartment during the step computation.

**Maximum Trabecular Spot Size** numeric text box - Sets the maximum trabecular spot size during the Segment Bone Compartments step. The smaller the maximum trabecular spot size, the more bone will be included in the trabecular bone compartment during the step computation.

**Minimum Bone Segment Volume** numeric text box - Sets the minimum bone segment volume during the Separate Bones step. Any bone segment below the minimum bone segment size will not be segmented during the step computation.

**Minimum Bone Size** numeric text box - Sets the minimum bone size to compute during the Detect Bones step. Any bone below the minimum bone size will not be detected during the step computation.

**Overall** check box - Computes all trabecular and cortical measurements during the ASBMR Measurements step.

**Pick Bones** button - Selects the bone whose properties you want to measure. During the Join Segments step, click the Pick Bones button and shift-click the bones to join together.

**Pre-Processing Smoothing** slider - Move the **Pre-Processing Smoothing** slider closer to **smooth** to decrease the ability to separate bone segments that are close together. Move the slider closer to **coarse** to increase the ability to separate bone segments that are close together.

**Reset** button - Returns the current Step Settings to their default values. The Reset button displays on the top right side of the Step Setting Tab.
Step Settings Tab (Continued)

**Rod Densities** check boxes - Use the default settings for newly purchased BMD calibration phantoms. For phantoms that contain rods with different densities, adjust the settings accordingly.

**Rotate X** button - Rotates the angle of the ROI in the X direction.

**Rotate Y** button - Rotates the angle of the ROI in the Y direction.

**Rotate Z** button - Rotates the angle of the ROI in the Z direction.

**Sensitivity** slider - Sets the amount of bone segments to compute during the Separate Bone Step computation. Move the slider closer to low to display fewer bone segments. Move the slider closer to high to display with more bone segments.

**Show ROI** check box - When selected, displays the ROI box on the 3D Visualization Tab. If cleared, the ROI is box not displayed.

**Trabecular** check boxes - Computes the selected trabecular bone measurements during the ASBMR Measurements step.

**X Center** numeric text box - Moves the center of the ROI in the X direction.

**X Size** numeric text box - Changes the size of the ROI in the X direction.

**Y Center** numeric text box - Moves the center of the ROI in the Y direction.

**Y Size** numeric text box - Changes the size of the ROI in the Y direction.

**Z-Axis Aligned** check box - Computes the selected the Z-Axis aligned measurements during the ASBMR Measurements step.

**Z Center** numeric text box - Moves the center of the ROI in the Z direction.

**Z Size** numeric text box - Changes the size of the ROI in the Z direction.
Visualization Settings Tab

Use the Visualization Settings Tab to adjust the window, level, colormap, 3D display, 2D display, ROI display, and both the 2D and 3D display properties of the scan opened on the 3D Visualization Tab.

![Visualization Settings Tab](image)

**Figure 68. Visualization Settings Tab**

The Visualization Settings Tab contains the following options:

- **Window** numeric text box - Adjusts the range of Hounsfield units displayed on the 3D Visualization Tab. Larger windows display larger ranges of tissue density. Smaller windows display smaller ranges of tissue density.

- **Level** numeric text box - Adjusts the HU number in the center of the window.

- **Colormap** drop-down list - Applies the selected colormap to the image on the 3D Visualization Tab.
Visualization Settings Tab (Continued)

**Histogram** - Reflects the distribution of voxel intensities in the 3D image as a function of HU. The histogram is display only and cannot be manually adjusted.

**3D Display** options:
- **Raw Data** check box - If selected, displays the raw 3D scan data.
- **Computed Data** check box - If selected, displays the processed 3D scan data.
- **Raw Data** check box and the **Computed Data** check box - If both are selected, displays the raw data inside the computed data.

**2D Display** options:
- **Raw Slices** check box - If selected, displays the raw scan data of the slices.
- **Computed Slices** check box - If selected, displays the processed scan data of the slices.
- **Raw Slices** check box and the **Computed Slices** check box - If both are selected, displays the raw slice data inside the computed slice data.
- **Transparency** slider - Move the slider closer to 1 to increase the bone transparency on the 2D slices. Move the slider closer to 0 to decrease the bone transparency on the 2D slices.
- **X-Slice** numeric text box - Moves the location of the X-slice to the location entered in the text box.
- **Y-Slice** numeric text box - Moves the location of the Y-slice to the location entered in the text box.
- **Z-Slice** numeric text box - Moves the location of the Z-slice to the location entered in the text box.

**Show ROI** check box - If selected, the ROI displays on the 3D Visualization Tab. If cleared, the ROI does not display.

**2D and 3D Display** options:
- **Invert X** check box - If selected, the scan is inverted along the x-axis.
- **Invert Y** check box - If selected, the scan is inverted along the y-axis.
- **Invert Z** check box - If selected, the scan is inverted along the z-axis.
Workflow Viewer Tab

The Workflow Viewer Tab displays at the bottom of the AccuCT Main Window. Use the Workflow Viewer tab to view the workflow name, current step in the workflow, and the current status of the workflow step. The Workflow Viewer tab is also used to start and review step computations.

NOTE

Some steps listed in the Workflow Step Boxes are optional.

The Workflow Viewer Tab contains the following options:

 Workflow name - The current workflow type. Displays on the left side of the tab.

 Step Box - Displays the Step Name, Input button, Results button, Compute button, and Step Status for each step.

 Step Name - The name of the step. Displays at the top of each Step Box.

 Step Status - Colored circles that display at the right side of each step box. Each color represent the status of the step:

• Solid Green - Step was successfully computed.
• Hollow Green - Step is enabled and can be performed.
• Yellow - Step settings have been changed since the last time the step was successfully computed.
• Rotating, Blue - Step computation in process.
• Red Circle - Step computation failed. Step can be re-computed using different step settings to attempt to correct the problem.
Workflow Viewer Tab (Continued)

**Inputs** button - Enables the Step Settings Tab to select the settings for the step computation. Also displays the volume in the 3D viewer used as input for the computation of the step.

**Compute** button - Starts the step computation.

**Results** button - Enables the Step Settings Tab to view the computation settings used to perform the step. Also displays the results of the computation (a 3D volume, a table of measurements, or a plot).
About Window

The About window displays the software version number and technical support contact information. To open the About window, select About from the Help Menu.

Figure 70. About Window
Add Groups Window

Use the Add Groups Window create a study group. To open the Add Groups Window, click the **Add a study group** button on **Study Info Tab**.

![Add Groups Window](image)

**Figure 71. Add Groups Window**

The Add Groups Window contains the following options:

- **Enter a study group name** text box - The name of the study group.
- **Enter a description** text box - The description of the study group.
- **Group Type** drop-down list - The desired group type (Positive Control, Negative Control, Vehicle, Treatment, or Experiment) for the study group.
- **Selected Agents** text box - The agents selected from the check box or boxes in the Available Agents text box.
- **Available Agents** text box - Displays all imaging agents added to the study from the **Select Agents Window**. A check box displays next to the agent names.
- **OK** button - Creates a study with the selected options.
- **Cancel** button - Closes the window without adding groups to the study.
Change HU Calibration Window

Use the HU Calibration Window to adjust the raw grayscale values in a scan and convert the values to Hounsfields Units. To open the HU Calibration Window, right-click the scan and select Change HU calibration from the context menu.

The Change HU Calibration Window contains the following options:

- **Slope** numeric text box - The slope to be applied when converting raw grayscale values to Hounsfield units.
- **Intercept** numeric text box - The intercept to be applied when converting raw grayscale values to Hounsfield units.
- **OK** button - Saves the scan with the slope and intercept HUs.
- **Cancel** button - Closes the Change HU Calibration Window without saving changes to the slope and intercept HUs.
Choose Calibration Scan Window

Use the Choose Calibration Scan Window to associate a completed BMD Calibration Workflow to scan data. To open the Choose Calibration Scan Window, right-click the scan data associated with an animal on the Animals & Data Tab and select Associate BMD calibration from the context menu.

The Choose Calibration Scan Window contains the following options:

**This study has no calibration** text box - Displays if a completed BMD Calibration Workflow has not been completed.

**Phantom Type** - The phantom type scan selected from the Import Phantom Data Window.

**Phantom Scan** - The phantom scan selected from the Import Phantom Data Window.

**Calibrate BMD workflow** - The completed Calibrate BMD workflow performed on the phantom scan.

**OK** button - Associates the Calibrate BMD workflow with the scan selected from the Animals & Data Tab. A green C displays next to the calibrated scan on the Animals & Data Tab.

**Cancel** button - Closes the Choose Calibration Scan Window without associating a Calibrate BMD workflow with the scan.
Import Data Window

Use the Import Data Window to associate scan data (VOX files, multi-frame DICOM files, or DICOM folders) with animals a study. To open the Import Data Window, select File → Load Scan Data from the Menu Bar or right-click the animal to associate with the scan data and select Import.

Figure 74. Import Data Window

The Import Data Window contains the following options:

File text box - Displays the name of the scan to import.

Associate With drop-down list - Select the animal to associate with the scan to import.

Add Files button drop-down list - Select Add Files from the drop-down list to import a multi-frame DICOM file or VOX file. Select Add DICOM Folder from the drop-down list to import a DICOM folder.

Import button - Imports the selected scan and associates the scan with the animal selected from the Associate With drop-down list.

Cancel button - Cancels the import and closes the Import Data Window.
Import Phantom Data Window

Use the Import Phantom Data Window to associate a phantom type to a phantom scan. To open the Import Phantom Data Window, select **File → Load BMD Phantom Data** from the Menu Bar or click the **Import BMD Phantom Data** button on the **Calibration Data Tab**.

![Import Phantom Data Window](image)

**Figure 75. Import Phantom Data Window**

The Import Phantom Data Window contains the following options:

- **File(s) text box** - Displays the name of the phantom scan to import.
- **Phantom type drop-down list** - Displays the phantom types to associate with the phantom scan.
- **Add Files button drop-down list** - Select **Add Files** from the drop-down list to import a multi-frame DICOM file or VOX file. Select **Add DICOM Folder** from the drop-down list to import a DICOM folder.
- **Import button** - Imports the selected phantom scan and associates the scan with the phantom type selected from the **Phantom type** drop-down list.
- **Cancel button** - Cancels the import and closes the Import Phantom Data Window.
Manage Animals Window

Use the Manage Animals Window to name animals, add animals, add animal parameters, or edit animals in the study. To open the Manage Animals Window, click the **Add or edit an animals** button on **Study Info Tab** after a study is created or opened.

![Figure 76. Manage Animals Window](image)

The Manage Animals Window contains the following options:

- **Animal Type** drop-down list - Select the type of animal in the study or study group.
- **Strain, Breed, or Subspecies** drop-down list - Select the strain or breed of animal in the study or study group.
- **Sex** drop-down list - Select the sex of the animals in the study or study group.
- **Birth Date** numeric text box - Type the birth date of the animal or select the date from the pop-up calendar.
- **Weight (gm/kg)** numeric text box - Type the weight of the animal in grams/kilograms or use the arrow keys to increase or decrease the weight.
- **Animals are named** radio button - If selected, custom names are assigned to the animals in the study.
- **Animals have IDs** radio button - If selected, ID names are assigned to animals in the study.
- **Starting ID** text box - Displays if the Animal have IDs radio button is selected. Type over *ID* in the text box with a starting ID number, letter, or name.
Manage Animals Window (Continued)

**Animal(s)** numeric text box - Type the number of animals to add to the study or use the arrows to increase or decrease the number of animals.

**Add** button - Fills the table on the Manage Animals Window with the assigned animals names, types, subspecies (strain or breed), sex, birth dates, weights, and study group (if applicable).

**Done** button - Adds the animal names from the table onto the Animals & Data Tab.

**Restore** button - Opens the Restore Animals to Study Window to restore animals removed from the study.
New Study Window

Use the New Study Window to name and create a study. To open the New Study Window, select **File → New Study** from the **Menu Bar** or press **CTRL + N**.

![Figure 77. New Study Window](image)

The New Study Window contains the following options:

- **Enter a study name** text box - The name of the study.
- **Create Study** button - Creates the study and displays the study name on top of the **Animals & Data Tab**.
- **Cancel** button - Closes the New Study window without applying the study name.
Open Study Window

Use the Open Study Window to open a current study. To open the Open Study Window, select **File → Open Study** from the **Menu Bar** or press **CTRL + O**.

![Open Study Window](image)

**Figure 78. Open Study Window**

- **Find studies** text box - Type a study name or search term to locate a study to be opened.
- **List of studies** - Displays current study names.
- **Open** button - Opens the selected study.
Restore Animals to Study Window

Use the Restore Animals to Study Window to restore animals removed from a study. To open the Restore Animals to Study Window, click the **Restore** button on the Manage Animals Window.

![Figure 79. Restore Animals to Study Window](image)

The Restore Animals to Study Window contains the following options:

- **Restore Animals** check boxes - Select the check box(es) of the animal(s) to be restored to the study.
- **Restore** button - Restores the selected animal(s) to the study.
Select Agents Window

Use to the Select Agents Window to add the agents used in the study. To open the Select Agents Window, click the **Add an agent button** on the **Study Info Tab**.

![Select Agents Window](image)

Figure 80. Select Agents Window

The Select Agents Window contains the following options:

- **Modality Type** drop-down list - Select the modality type used in the study or study group: Fluorescent, Luminescent, PET, or CT.

- **Agent Text Box** - Lists the agent applicable to the modality type. When the arrow is clicked, the specific agent names display.

- **Add button** - Adds the selected agent to the study or study group.

- **Cancel button** - Closes the Select Agents window without adding an agent.

- **Agent Details** - Displays the name, vendor, and other details of the selected agent.
Troubleshooting

If any of the following problems occur when using the AccuCT software, follow the suggestions to correct the problem:

NOTE

It these or other problems you experience are not resolved, contact PerkinElmer Technical Support (see page 2).

• Cannot Add Animals to a Study
• Cannot Compute a Step
• Cannot Pick Bones
• Cannot View 2D or 3D Display
• Errors When Importing Study Data
Cannot Add Animals to a Study

Done button not clicked on the Manage Animals Window.

To add animals to a study:

1. Click the **Add or edit animals** button on the **Study Info Tab**. The **Manage Animals Window** opens.
2. Complete the fields on the **Manage Animals Window**. See page 108.
3. Click the **Add** button. If the Add button is not clicked before the **Done** button, the animals will not be added.
4. Click the **Done** button. The **Manage Animals Window** closes and the animal names display on the **Animals & Data Tab**.

Cannot Compute a Step

Input button on step box not clicked.

To compute a step:

1. Click the **Inputs** button in the step box on the **Workflow Viewer Tab**. If the **Inputs** button is not clicked before the **Step Settings Tab**, the step computation may not work.
2. Click the **Step Settings Tab** and change the default setting if desired.
3. Click the **Compute** button in the step box on the **Workflow Viewer Tab**. The results of the step display.

Cannot Pick Bones

Done button not clicked after bone(s) selected with Pick Bones Button.

To pick the desired bone or bones:

1. Click the **Pick Bones** button and select the bone whose properties you want to measure
   
   OR
   
   Click the **Pick Bones** button and shift-click the bones to join together during the Join Segments step.
2. Click the **Done** button on the **Step Settings Tab**.
Cannot View 2D or 3D Display

Incorrect settings on computers with dual graphic cards.

If your computer (mostly laptops) is equipped with dual graphic cards, the graphics driver needs to changed from default to the high-performance graphics card for the AccuCT software. Otherwise, the 3D Visualization Tab may not function correctly.

To change the graphics driver to the high-performance graphics card:

1. Open the NVIDIA control panel and click Manage 3D settings on the Program Settings tab.

2. Add the AccuCT executable (AccuCT.exe) as the program to customize and then set the preferred graphics processor to High-performance NVIDIA processor.

Errors When Importing Study Data

Incorrect .csv or .yaml file format.

See Importing Study Data on page 30 to correct the formatting.
CLICK-THROUGH LICENSE AGREEMENT

***IMPORTANT INFORMATION-PLEASE READ CAREFULLY***

This Software contains computer programs and other proprietary material and information, the use of which is subject to and expressly conditioned upon acceptance of this License Agreement (the “Agreement”). This Agreement is a legally binding agreement between you (meaning the individual person or the entity that the individual represents that has obtained the Software for its internal productive use and not for outright resale) (the “Licensee”) and PerkinElmer Health Sciences, Inc., with offices at 68 Elm Street, Hopkinton, MA 01748 (“PerkinElmer”). This Agreement governs Licensee’s use of the Software, except to the extent all or any portion of the Software is governed by a third party licensor’s terms and conditions. Further, this Agreement shall prevail over any other terms or conditions regarding your use of the Software, except to the extent a separate agreement is agreed to in writing by PerkinElmer that specifically refers to the Software.

BY CLICKING ON THE “ACCEPT” BUTTON, YOU ARE (I) REPRESENTING TO PERKINELMER THAT YOU ARE AUTHORIZED TO BIND THE LICENSEE; (II) AGREEING ON BEHALF OF THE LICENSEE THAT THE TERMS OF THIS AGREEMENT SHALL GOVERN THE RELATIONSHIP OF THE PARTIES WITH REGARD TO THE SUBJECT MATTER IN THIS AGREEMENT AND ARE WAIVING ANY RIGHTS, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, TO ANY CLAIM ANYWHERE IN THE WORLD CONCERNING THE ENFORCEABILITY OR VALIDITY OF THIS AGREEMENT; AND (III) AGREEING THAT THE SOFTWARE IS ACCEPTED AS DELIVERED. IF YOU DO NOT HAVE AUTHORITY TO AGREE TO OR DO NOT ACCEPT THE TERMS OF THIS AGREEMENT ON BEHALF OF THE LICENSEE, PERKINELMER WILL NOT AND DOES NOT LICENSE THE SOFTWARE TO THE LICENSEE AND YOU MUST CLICK ON THE “DO NOT ACCEPT” BUTTON, CEASE ANY FURTHER ATTEMPT TO INSTALL, DOWNLOAD OR USE THIS SOFTWARE FOR ANY PURPOSE, AND REMOVE ANY PARTIAL OR FULL COPIES MADE FROM THIS SOFTWARE.

THIS IS A LICENSE AGREEMENT AND NOT AN AGREEMENT FOR SALE.

1 Definitions:
   a “Affiliates” means, with respect to a party to this Agreement, any Person that controls, is controlled by, or is under common control with that party. For the purpose of this definition, “control” shall mean, direct or indirect, ownership of fifty percent (50%) or more of the shares of stock entitled to vote for the election of directors, in the case of a corporation, or fifty percent (50%) or more of the equity interest in the case of any other type of legal entity, status as a general partner in any partnership, or any other arrangement whereby the entity or person controls or has the right to control the board of directors or equivalent governing body of a corporation or other entity, or the ability to cause the direction of the management or policies of a corporation or other entity.
   b “Documentation” means user manuals, technical manuals and any other materials provided by PerkinElmer, in printed, electronic or other form, that describe the installation, operation, use or technical specifications of the Software.
   c “Person” means an individual, corporation, partnership, joint venture, limited liability company, governmental authority, unincorporated organization, trust, association or other entity.
   d “Software” means the AccuCT™ software program(s) for which Licensee is purchasing a license, as may be set forth in any purchase order, and also includes any associated hardware. Software also includes any updates, purchased modules, and/or purchased upgrades to the Software that Licensee may receive and/or purchase from time to time under a separate services or support contract.
   e “Third Party” means any Person other than PerkinElmer and Licensee.

2 License Types. The Software is being licensed to Licensee under a Node-Locked License (as hereinafter defined) or as a Concurrent User License (as hereinafter defined). Such license type and associated license fees shall be specified on the quotation, purchase order or order acknowledgment form.
   a “Node-Locked License”: Under the terms of a Node-Locked License, the Software is licensed for use on a specified computer or computing device. This Node-Locked License is only authorized to be used on this specified computer or computing device. A Node-Locked License permits the use of a single instance of the Software which functions on a single computer or computing device.
   b “Concurrent User License”: Under the terms of a Concurrent User License, the Software is licensed for use by a specified maximum number users simultaneously accessing the Software on any number of computers, but only up to the specified maximum number of users licensed.
3 **License Scope.** Subject to and conditioned upon Licensee’s payment of any license fees due for the license type granted hereunder and Licensee’s strict compliance with all terms and conditions set forth in this Agreement, PerkinElmer hereby grants to Licensee a non-exclusive, non-transferable, non-sublicensable, limited license during the Term to use, the Software, solely as set forth in this Section 3 and subject to all conditions and limitations set forth in Section 4 or elsewhere in this Agreement. This license grants Licensee the right to:

a **If Node-Locked License is purchased:** download, copy, and install, in accordance with the Documentation, the Software on a single computer owned or leased, or otherwise controlled by Licensee. Concurrent use on two or more computers and/or use in a local area network or other network is strictly prohibited without prior written authorization from PerkinElmer and the payment of any additional license fees. In addition to the foregoing, Licensee has the right to make a reasonable number of copies of the Software solely for archival and backup purposes; provided that Licensee shall not, and shall not allow any Person to, install or use any such copy other than if and for so long as the copy installed in accordance with the preceding sentence is inoperable and, provided, further, that Licensee uninstalls and otherwise deletes such inoperable copy. All copies of the Software made by the Licensee shall be the exclusive property of PerkinElmer; (ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright, patent and other intellectual property rights notices contained in the original;

b **If Concurrent User License is purchased:** download and install, in accordance with the Documentation, the Software on an unlimited number of computers, owned or leased, or otherwise controlled by Licensee. Licensee may use the Software by no more than the authorized number of concurrent users. A separate license is required for each additional concurrent user in which the Software is used. In addition to the foregoing, Licensee has the right to make a reasonable number of copies of the Software solely for archival and backup purposes; provided that Licensee shall not, and shall not allow any Person to, install or use any such copy other than if and for so long as the copy installed in accordance with the preceding sentence is inoperable and, provided, further, that Licensee uninstalls and otherwise deletes such inoperable copy. All copies of the Software made by the Licensee shall be the exclusive property of PerkinElmer; (ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright, patent and other intellectual property rights notices contained in the original;

c use and run the Software, in executable code only, as properly installed in accordance with this Agreement and the Documentation; and

d download or otherwise make one (1) copy of the Documentation and use such Documentation, solely in support of its licensed use of the Software in accordance herewith. All copies of the Documentation made by Licensee: (i) will be the exclusive property of PerkinElmer; (ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright, patent and other intellectual property rights notices contained in the original;

4 **Free Trial License.** If PerkinElmer is providing to Licensee a free trial version, PerkinElmer will make certain Software available to Licensee on a trial basis (the “Trial Version”) free of charge until the end of the free trial period for which PerkinElmer has designated. The Trial Version may be used only to review, demonstrate and evaluate the Software and may have limited features. The Trial Version may cease operating after the applicable time period or number of uses, which may be based on an internal metering mechanism within the Trial Version itself. Regardless of any such metering, Licensee must stop use at the end of such period or number of uses. Additional trial terms and conditions may be incorporated into this EULA by reference and are legally binding. Review the Documentation during the free trial so that Licensee is familiar with the features and functions of the Software before Licensee applies the applicable Software.

Licensee shall not (A) in the aggregate, install or use more than one copy of the Trial Version of the Software, (B) alter the contents of a hard drive or computer system to enable the use of the Trial Version of the Software for an aggregate period in excess of the trial period for one license to such Trial Version, (C) disclose the results of software performance benchmarks obtained using the Trial Version to any third party without PerkinElmer’s prior written consent, (D) use the Trial Version for any commercial training or any application deployment or ultimate production purpose, or (E) use the Trial Version of the Software for a purpose other than the sole purpose of determining whether to purchase a license to the Software.

**ANY DATA LICENSEE ENTERS INTO THE SOFTWARE, AND ANY CONFIGURATIONS MADE TO THE SOFTWARE BY OR FOR LICENSEE DURING ANY FREE TRIAL MAY BE PERMANENTLY LOST UNLESS YOU PURCHASE A LICENSE TO THE SAME SOFTWARE AS THOSE COVERED BY THE TRIAL. PURCHASE UPGRADED SOFTWARE, OR EXPORT SUCH DATA, BEFORE THE END OF THE TRIAL PERIOD.**

5 **Restrictions.** Licensee shall not, and shall require its employees and/or other authorized users not to, directly or indirectly:

a use (including make any copies of) the Software and/or Documentation beyond the scope of the license granted in Section 3;

b modify, translate, adapt or otherwise create derivative works or improvements, whether or not patentable, of the Software and/or Documentation or any part thereof;

c combine the Software or any part thereof with, or incorporate the Software or any part thereof in, any other programs;

d reverse engineer, disassemble, decompile, decode or otherwise attempt to derive or gain access to the source code of the Software or any part thereof;
e remove, delete, alter or obscure any trademarks or any copyright, trademark, patent or other intellectual property or proprietary rights notices from the Software or Documentation, including any copy thereof;

f except as expressly set forth in Sections 3(a), 3(b) and 3(c), copy the Software and/or Documentation, in whole or in part;

g rent, lease, lend, sell, resell, sublicense, assign, distribute, publish, transfer or otherwise make available the Software or any features or functionality of the Software, to any Third Party for any reason, whether or not over a network and whether or not on a hosted basis, including in connection with the internet, web hosting, wide area network (WAN), virtual private network (VPN), virtualization, time-sharing, service bureau, software as a service, cloud or other technology or service;

h use the Software in, or in association with, the design, construction, maintenance or operation of any hazardous environments or systems, including: (i) power generation systems; (ii) aircraft navigation or communication systems, air traffic control systems or any other transport management systems; (iii) safety-critical applications, including medical or life-support systems, vehicle operation applications or any police, fire or other safety response systems; and (iv) military or aerospace applications, weapons systems or environments;

i use the Software in violation of any federal, state or local law, regulation or rule;

j use the Software for purposes of competitive analysis of the Software, the development of a competing software product or service;

k install or use the Software on more than one computer simultaneously without the purchase of additional licenses and/or the express written consent of an authorized PerkinElmer representative; and/or

l use the Software to provide outsourcing, service bureau, online services or trainings to a Third Party, without the express written consent of an authorized officer of PerkinElmer.

6 Third Party and Open Source Software. The Software may include libraries, components, utilities, and/or other computer software supplied by Third Parties, including, but not limited to, those set forth in Appendix A (the "Third Party Software"). PerkinElmer is providing the Third Party Software to Licensee under license by the respective licensors and/or copyright holders on the terms provided by such Third Parties, including those terms required to be provided to Licensee as set forth in Appendix A, and subject to this Agreement. Further, the Software may contain or be provided with open source libraries, components, utilities and other open source software (collectively, "Open Source"), which Open Source may have applicable license terms included in Appendix A, or as otherwise may be provided with the applicable Documentation. Notwithstanding anything to the contrary herein, use of the Open Source and/or Third Party Software shall be subject to the applicable Open Source and/or Third Party Software license terms and conditions to the extent required by the applicable licensor (which terms shall not restrict the license rights granted to Licensee hereunder but may contain additional rights) and such Open Source and/or Third Party Software license terms shall only apply to such Open Source and/or Third Party Software component and not the entire Software. Any breach by Licensee of any Open Source and/or Third Party Software license shall also be deemed a breach of this Agreement. In the event of a conflict between the Open Source and/or Third Party Software license and this Agreement, the Open Source and/or Third Party Software license will prevail solely with respect to the Open Source and/or Third Party Software component. PerkinElmer makes no promises, representations or warranties regarding any Open Source and/or Third Party Software. Upon written request, PerkinElmer will provide a complete list of all Open Source and/or Third Party Software with licenses applicable to the Licensee. For avoidance of doubt, Licensee does not need to obtain any additional licenses to use the Software pursuant to the terms of this Agreement.

7 Responsibility for Use of Software. Licensee is responsible and liable for all uses of the Software through access thereto provided by Licensee, directly or indirectly. Specifically, and without limiting the generality of the foregoing, Licensee is responsible and liable for all actions and failures to take required actions with respect to the Software by its employees or by any other Person to whom Licensee may provide access to or use of the Software, whether such access or use is permitted by or in violation of this Agreement.

8 Security Mechanisms. PerkinElmer and its Affiliates endeavor to take all legal actions available to it to eliminate piracy of its software products. As such, the Software may include a security mechanism which collects and transmits usage data for the purpose of detecting the installation or use of illegal copies of the Software. Data collected will not include any Licensee data created with the Software. Licensee consents to such detection and collection of data, as well as its transmission and use. PerkinElmer also reserves the right to use a hardware lock device, license administration software, and/or a license authorization key to control access to the Software. Licensee shall not take any steps to avoid, remove, disable, circumvent, defeat, or otherwise create or implement any workaround to any such measures. Use of the Software by Licensee without the required lock device or authorization key provided by PerkinElmer is strictly prohibited.
Compliance. PerkinElmer may, in PerkinElmer’s sole discretion, audit the Licensee’s use of the Software under this Agreement at any time during the Term to ensure Licensee’s compliance with this Agreement, provided that (i) any such audit shall be conducted on not less than ten (10) business days’ prior notice to Licensee, and (ii) no more than one audit may be conducted in any twelve (12) month period except for good cause shown. PerkinElmer also may, in its sole discretion, audit Licensee’s systems within twelve (12) months after the end of the Term to ensure Licensee has ceased use of the Software and removed all copies of the Software from such systems as required hereunder. Licensee shall reasonably cooperate with PerkinElmer’s personnel conducting such audits and provide all reasonable access requested by the PerkinElmer to records, systems, equipment, information and personnel, including serial numbers and related information. PerkinElmer shall examine information directly related to the Licensee’s use of the Software. PerkinElmer may conduct audits only during Licensee’s normal business hours and in a manner that does not unreasonably interfere with the Licensee’s business operations.

Ownership. The Software is licensed, not sold, to Licensee subject to the terms of this Agreement. PerkinElmer reserves all rights not expressly granted to Licensee. Licensee owns the media, if any, on which the Software is recorded, but PerkinElmer retains ownership of all copies of the Software itself. Licensee acknowledges that the Software contains and embeds valuable, unpublished information that is proprietary and confidential to PerkinElmer and its licensors and suppliers. Licensee agrees to keep all such information confidential. This does not preclude Licensee from using information Licensee lawfully obtain from another source.

Term. This Agreement is effective on the date Licensee accepts this Agreement and/or downloads or installs the Software, whichever is earlier, and will continue until terminated. This Agreement and the licenses granted hereunder will terminate immediately without notice to Licensee if (i) Licensee materially breaches any term or condition of this Agreement; or (ii) if Licensee files, or has filed against it, a petition for voluntary or involuntary bankruptcy or pursuant to any other insolvency law, makes or seeks to make a general assignment for the benefit of its creditors or applies for, or consents to, the appointment of a trustee, receiver or custodian for a substantial part of its property. Licensee also may terminate this Agreement, at any time, by destroying the Software and all copies thereof. Upon any termination, the license granted to Licensee shall immediately cease and Licensee agrees to discontinue all use of the Software, promptly erase all copies of the Software and portions thereof from Licensee’s computer storage or any other media, and return or destroy all copies of the Software. Termination is not an exclusive remedy.

Limited Warranty. PerkinElmer’s sole warranty with respect to the Software is that for a period of ninety (90) days from the date of receipt, the Software will substantially contain the functionality described in the published specifications, and when properly installed on a computer meeting the specifications set forth in, and operated in accordance with, the Documentation, will substantially perform in accordance therewith. THE FOREGOING WARRANTY DOES NOT APPLY, AND PERKINELMER STRICTLY DISCLAIMS ALL WARRANTIES, WITH RESPECT TO ANY THIRD PARTY MATERIALS.

Warranty Disclaimer. TO THE MAXIMUM EXTENT PERMISSIBLE UNDER APPLICABLE LAW, PERKINELMER EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT OF THIRD PARTY RIGHTS, AND ANY IMPLIED WARRANTIES ARISING FROM COURSE OF DEALING OR COURSE OF PERFORMANCE. PERKINELMER DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE LICENSEE’S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, PERKINELMER DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PERKINELMER SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO THE LICENSEE. THE TERMS OF THIS DISCLAIMER DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER ACQUIRING PERKINELMER PRODUCTS OTHERWISE THAN IN THE ORDINARY COURSE OF BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL INJURY CAUSED BY PERKINELMER’S NEGLIGENCE OR WILLFUL MISCONDUCT.

Limitation of Liabilities. PerkinElmer’s and its Affiliates’ entire liability and Licensee’s sole and exclusive remedy shall be, at PerkinElmer’s sole discretion, either (A) the return of any license fee paid for the Software, or (B) correction or replacement of the Software that does not meet the terms of this limited warranty and that is returned to PerkinElmer with a copy of the purchase receipt. REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT WILL PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS BE LIABLE TO LICENSEE OR ANY THIRD PARTY UNDER ANY LEGAL THEORY OF LIABILITY FOR ANY LOSS OF PROFITS OR REVENUE, LOSS OR INACCURACY OF DATA, INTERRUPTION OF BUSINESS, COST OF SUBSTITUTION, INTERRUPTION, DELAY, LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, BREACHES IN SYSTEM SECURITY, OR ANY OTHER INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL DAMAGES OF ANY NATURE ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF PERKINELMER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND WHETHER OR NOT SUCH DAMAGES ARE FORESEEABLE. IN NO EVENT WILL THE LIABILITY OF PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS EXCEED THE GREATER OF ONE U.S. DOLLAR OR THE LICENSE FEE RECEIVED BY PERKINELMER FROM LICENSEE FOR THE SOFTWARE. Some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, so the above exclusion may not apply.
15 **U.S. Government End Users.** The Software is commercial computer software, as such term is defined in 48 C.F.R. §2.101. Accordingly, if the Licensee is the US Government or any contractor therefor, Licensee shall receive only those rights with respect to the Software and Documentation as are granted to all other end users under license, in accordance with (a) 48 C.F.R. §227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government licensees and their contractors. If this Agreement fails to meet the Government’s minimum needs or is inconsistent in any respect with Federal procurement law, the Government agrees to return this software, unused, to PerkinElmer.

16 **Export Law.** The Software is subject to U.S. export control laws and may be subject to export or import regulations in other countries. Licensee agrees to strictly comply with all such laws and regulations and acknowledge that Licensee has the responsibility to obtain any required export, re-export, or import licenses. Licensee agrees to indemnify and hold PerkinElmer harmless from all claims, losses, liabilities, damages, fines, penalties, costs and expenses relating to Licensee’s breach of these obligations.

17 **Trademark Acknowledgement.** The PerkinElmer logo is a registered trademark of PerkinElmer, Inc. PerkinElmer is a registered trademark of PerkinElmer, Inc. and/or its Affiliates. AccuCT is a trademark of PerkinElmer, Inc. and/or its Affiliates. All other Third Party brands, products, service names, trademarks, or registered service marks are used to identify the products or services of their respective owners, and are the property of their respective holders.

18 **General.**

a) This Agreement will be governed by the laws of the Commonwealth of Massachusetts, without giving effect to conflict of laws principles that require the application of the laws of any other jurisdiction. The UN Convention on Contracts for the International Sale of Goods will not apply to this Agreement. Licensee hereby irrevocably submits to the personal jurisdiction and venue of, and agrees to service of process issued or authorized by, state and federal courts with jurisdiction over Suffolk County, Massachusetts, and Licensee waives any objection thereto. The prevailing party in any action under this Agreement is entitled to receive its costs and expenses, including reasonable attorneys’ fees, incurred in that action, in addition to any other relief it may receive.

b) If any term or provision of this Agreement is invalid, illegal or unenforceable in any jurisdiction, such invalidity, illegality or unenforceability shall not affect any other term or provision of this Agreement or invalidate or render unenforceable such term or provision in any other jurisdiction. This Agreement may only be amended, modified or supplemented by an agreement in writing signed by each party hereto. No waiver by any party of any of the provisions hereof shall be effective unless explicitly set forth in writing and signed by the party so waiving. Except as otherwise set forth in this Agreement, no failure to exercise, or delay in exercising, any right, remedy, power or privilege arising from this Agreement shall operate or be construed as a waiver thereof; nor shall any single or partial exercise of any right, remedy, power or privilege hereunder preclude any other or further exercise thereof or the exercise of any other right, remedy, power or privilege. Licensee may not assign or delegate this Agreement, nor any rights or duties hereunder, in whole or in part, without PerkinElmer’s prior written approval, which may be withheld in its sole discretion, and any purported attempt to do so is void. Only a written amendment referencing this Agreement and executed and delivered by both parties can modify this Agreement.

c) PerkinElmer shall not be in default hereunder by reason of any failure or delay in the performance of its obligations hereunder where such failure or delay is due to strikes, labor disputes, civil disturbances, riot, rebellion, invasion, epidemic, hostilities, war, terrorist attack, embargo, natural disaster, acts of God, flood, fire, sabotage, fluctuations or non-availability of electrical power, heat, light, air conditioning or Licensee equipment, loss and destruction of property or any other circumstances or causes beyond PerkinElmer’s reasonable control.

d) This Agreement and all other documents that are incorporated by reference herein, constitutes the sole and entire agreement between PerkinElmer and Licensee with respect to the subject matter contained herein, and supersedes all prior and contemporaneous understanding, agreements, representations and warranties, both written and oral, with respect to such subject matter. This Agreement shall be construed without regard to any presumption or rule requiring construction or interpretation against the party drafting an instrument or causing any instrument to be drafted.
Appendix A - Third Party Software

Event Store:
Copyright (c) 2011-2014, Event Store LLP. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
Neither the name of Event Store LLP nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

AggregateSource:
Copyright (c) 2013, Yves Reynhout. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
Neither the name of the BitTacklr nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

CommonDomain:
Copyright (c) 2011 Jonathan Oliver.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
MahApps.Metro & ReactiveUI:
Microsoft Public License (Ms-PL)
This license governs use of the accompanying software. If you use the software, you accept this license. If you do not accept the license, do not use the software.

1 Definitions
The terms “reproduce,” “reproduction,” “derivative works,” and “distribution” have the same meaning here as under U.S. copyright law. A “contribution” is the original software, or any additions or changes to the software. A “contributor” is any person that distributes its contribution under this license. “Licensed patents” are a contributor's patent claims that read directly on its contribution.

2 Grant of Rights
a Copyright Grant - Subject to the terms of this license, including the license conditions and limitations in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free copyright license to reproduce its contribution, prepare derivative works of its contribution, and distribute its contribution or any derivative works that you create.

b Patent Grant - Subject to the terms of this license, including the license conditions and limitations in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free license under its licensed patents to make, have made, use, sell, offer for sale, import, and/or otherwise dispose of its contribution in the software or derivative works of the contribution in the software.

3 Conditions and Limitations
a No Trademark License - This license does not grant you rights to use any contributors' name, logo, or trademarks.

b If you bring a patent claim against any contributor over patents that you claim are infringed by the software, your patent license from such contributor to the software ends automatically.

c If you distribute any portion of the software, you must retain all copyright, patent, trademark, and attribution notices that are present in the software.

d If you distribute any portion of the software in source code form, you may do so only under this license by including a complete copy of this license with your distribution. If you distribute any portion of the software in compiled or object code form, you may only do so under a license that complies with this license.

e The software is licensed “as-is.” You bear the risk of using it. The contributors give no express warranties, guarantees or conditions. You may have additional consumer rights under your local laws which this license cannot change. To the extent permitted under your local laws, the contributors exclude the implied warranties of merchantability, fitness for a particular purpose and non-infringement.

NLog:
Copyright (c) 2004-2011 Jaroslaw Kowalski, jaak@jkowalski.net. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Newtonsoft Json.NET:
The MIT License (MIT).
Copyright (c) 2007 James Newton-King.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

SPLAT:
Copyright (c) 2013 Paul Betts.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Fellow Oak DICOM:
Microsoft Public License (Ms-PL)

This license governs use of the accompanying software. If you use the software, you accept this license. If you do not accept the license, do not use the software.

1 Definitions
The terms "reproduce," "reproduction," "derivative works," and "distribution" have the same meaning here as under U.S. copyright law. A "contribution" is the original software, or any additions or changes to the software. A "contributor" is any person that distributes its contribution under this license. "Licensed patents" are a contributor's patent claims that read directly on its contribution.

2 Grant of Rights
a Copyright Grant - Subject to the terms of this license, including the license conditions and limitations in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free copyright license to reproduce its contribution, prepare derivative works of its contribution, and distribute its contribution or any derivative works that you create.

b Patent Grant - Subject to the terms of this license, including the license conditions and limitations in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free license under its licensed patents to make, have made, use, sell, offer for sale, import, and/or otherwise dispose of its contribution in the software or derivative works of the contribution in the software.

3 Conditions and Limitations
a No Trademark License - This license does not grant you rights to use any contributors' name, logo, or trademarks.

b If you bring a patent claim against any contributor over patents that you claim are infringed by the software, your patent license from such contributor to the software ends automatically.

c If you distribute any portion of the software, you must retain all copyright, patent, trademark, and attribution notices that are present in the software.

d If you distribute any portion of the software in source code form, you may do so only under this license by including a complete copy of this license with your distribution. If you distribute any portion of the software in compiled or object code form, you may only do so under a license that complies with this license.

e The software is licensed "as-is." You bear the risk of using it. The contributors give no express warranties, guarantees or conditions. You may have additional consumer rights under your local laws which this license cannot change. To the extent permitted under your local laws, the contributors exclude the implied warranties of merchantability, fitness for a particular purpose and non-infringement.
Index

Numerics
2D Display Visualization Settings ........................................ 47
3D Display Visualization Settings ........................................ 48
3D Visualization Tab ......................................................... 92

A
About Window ........................................................................ 102
AccuCT software
Basic Operation ................................................................. 13
Changing the View of the Main Window ................................ 16
Closing ............................................................................. 17
Installing ........................................................................... 14
Opening .............................................................................. 15, 17
Add Groups Window ............................................................ 103
Adjusting the Scan Data Properties ....................................... 43
Animals & Data Tab ............................................................. 88
Animals in a Study ................................................................ 24
ASBMR Morphometry Workflow ........................................ 50
ASMBR Measurements Step ................................................ 66
Associating a Calibrate BMD Workflow .................... 68, 75
Associating BMD Phantom Scan Data ................................... 69
Associating Scan Data ......................................................... 38

B
BMD Measurements Step .................................................... 78
Bone Growth Measurements Step ......................................... 82
Bone Growth Workflow ....................................................... 80
Bone Loss Measurements Step .............................................. 82
Bone Loss Workflow .......................................................... 80

C
Calibrate BMD Workflow ..................................................... 68
Calibration Data Tab ............................................................. 89
Change HU Calibration Window ........................................... 104
Changing the HU Calibration ................................................. 49
Changing the View of the Main Window ......................... 16
Choose Calibration Scan Window ........................................ 105
Closing the Software ........................................................... 17
Colormap ........................................................................... 46
Creating a Study ................................................................. 19
Customer Support plans ..................................................... 3

D
Data Analysis ....................................................................... 35
Define ROI Step ................................................................... 63
Defining Study Parameters .................................................. 20
Detect Bones Step ............................................................... 52

E
Exporting Measurement Results .......................................... 83

F
File Menu ........................................................................... 87

H
HU Calibration ..................................................................... 49

I
Imaging Agents ................................................................... 22
Import Data Window ............................................................ 106
Import Phantom Data Window ............................................. 107
Importing Study Data ........................................................... 30
Formatting the File ............................................................... 30
Review the File for Errors .................................................... 33
Installing the Software ......................................................... 14
Invert Scan .......................................................................... 48
Join Segments Step .............................................................. 58

J
Main Window ....................................................................... 86
Change the View .................................................................. 16
Manage Animals Window ..................................................... 108
Measurements Tab ............................................................... 93
Menu Bar ............................................................................ 87

N
New Study Window .............................................................. 110

O
Open Study Window ............................................................ 111
Opening an Existing Workflow ........................................... 83
Opening an Existing Study ................................................... 29
Opening the Software ......................................................... 15, 17
Pan ..................................................................................... 41

P
Plots Tab ............................................................................. 94
Principles of Operation ......................................................... 8

Index 125
R
Recomputing a Step ................. 37
Renaming a Workflow ............. 84
Renaming Animals ................. 27
Reset
  Main Window View .............. 42
  Visualization Settings .... 49
Restore Animals to Study Window .112
Rotate ......................... 41

S
Scan ................................. 43
Scan Data
  Associating BMD Phantom . 69
  Associating with animals . 38
  Export Current View ........ 42
  Viewing ....................... 40
Segment Bone Compartments Step . 60
Segment More Step ............... 55
Select Agents Window ........ 113
Separate Bones Step ............ 53
Service plans ................... 3
Single Bone BMD Workflow .... 74
Software Agreement ............. 117
Starting
  ASBMR Morphometry Workflow . 51, 76
  Bone Growth Workflow ....... 81
  Bone Loss Workflow ......... 81
  Calibrate BMD Workflow ... 70
  Single Bone BMD Workflow . 76
  Whole Scan BMD Workflow .... 76
Step
  ASBMR Measurements .......... 66
  BMD Measurements .......... 78
  Bone Growth Measurements . 82
  Bone Loss Measurements . 82
  Define ROI ................... 63
  Detect Bones ................ 52
  Join Segments ............... 58
  Recomputing ................ 37
  Segment BMD Phantom ....... 71
  Segment Bone Compartments . 60
  Segment More ................ 55
  Separate Bones ............. 53
Step Settings Tab ............... 95
Study
  Analyzing ....................... 35
  Creating ........................ 19
  Defining Parameters .......... 20
  Importing Study Data ........ 30
  Opening ........................ 29
  Renaming Animals ............ 27
Study Groups .................. 23
Study Info Tab ................. 91
Study Parameters ............... 20
Support plans ................... 3
System Requirements .......... 12
T
Troubleshooting ................. 114
U
Understanding Workflows ....... 36
V
Viewing the Scan Data .......... 40
  Pan ............................ 41
  Rotate ........................ 41
  Zoom In ....................... 41
  Zoom Out ..................... 41
Visualization Settings
  2D Display ..................... 47
  3D Display ..................... 48
  Colormap ...................... 46
  Invert ........................ 48
  Reset ........................ 49
  Window and Level ............ 44
Visualization Settings Tab .... 98
W
Whole Scan BMD Workflow ....... 74
Window and Level ............... 44
Workflow Steps
  ASBMR Measurements Step .... 66
  BMD Measurements Step .... 78
  Bone Growth Measurements Step . 82
  Bone Loss Measurements Step. 82
  Define ROI Step ............. 63
  Detect Bones Step ........... 52
  Join Segments Step .......... 58
  Segment BMD Phantom ....... 71
<table>
<thead>
<tr>
<th>Segment Bone Compartments Step</th>
<th>60</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment More Step</td>
<td>55</td>
</tr>
<tr>
<td>Separate Bones Step</td>
<td>53</td>
</tr>
<tr>
<td>Workflow Viewer Tab</td>
<td>100</td>
</tr>
<tr>
<td>Workflows</td>
<td></td>
</tr>
<tr>
<td>ASBMR Morphometry</td>
<td>50</td>
</tr>
<tr>
<td>Bone Growth</td>
<td>80</td>
</tr>
<tr>
<td>Bone Loss</td>
<td>80</td>
</tr>
<tr>
<td>Calibrate BMD</td>
<td>68</td>
</tr>
<tr>
<td>Opening</td>
<td>83</td>
</tr>
<tr>
<td>Renaming</td>
<td>84</td>
</tr>
<tr>
<td>Single Bone BMD</td>
<td>74</td>
</tr>
<tr>
<td>Understanding</td>
<td>36</td>
</tr>
<tr>
<td>Whole Scan BMD</td>
<td>74</td>
</tr>
</tbody>
</table>

**Z**

| Zoom In                        | 41 |
| Zoom Out                       | 41 |